## Contents

**Preface** ....................................................................................................................... 7
  - Conventions .................................................................................................................. 7
  - Related Publications ..................................................................................................... 8
  - Customer Support ......................................................................................................... 8
  - Information You Should Have ......................................................................................... 9
  - User Feedback ............................................................................................................... 10
  - Information Builders Consulting and Training ............................................................ 10

**1. Using In-Document Analytics** .................................................................................... 11
  - In-Document Analytics Reports Overview ..................................................................... 11

**2. Creating Interactive Content With In-Document Analytics** ........................................ 15
  - Overview of In-Document Analytics ............................................................................ 15
  - Enabling In-Document Analytics in InfoAssist ............................................................ 23
  - Developing Interactive Content ..................................................................................... 24
    - Interactive Reports ..................................................................................................... 24
      - Configuring Analytic Document Options for Reports ............................................ 24
        - General Tab ......................................................................................................... 25
        - Menu Options Tab ............................................................................................... 26
        - Colors Tab ......................................................................................................... 27
        - Advanced Tab .................................................................................................... 28
      - Freezing Column Headings in Interactive Reports ............................................... 29
    - Interactive Charts .................................................................................................... 32
    - Interactive Dashboards ............................................................................................. 33
      - Analytic Document Prompts .................................................................................. 34
      - Target Reports ....................................................................................................... 34
      - Using Multiple Reports as Targets and Sources .................................................... 35
  - Working With Interactive Content .................................................................................. 43
    - Interactive Content Usage Considerations ................................................................ 51
    - Running Content in Full-Screen Mode ....................................................................... 54
    - Using the Ellipsis Menu to Perform Common Tasks .................................................. 56
    - In-Document Analytic Options for Reports ............................................................... 58
      - Designer Style Report Cell Menu Options ............................................................. 59
## Contents

- Legacy Report Cell Menu Options .......................................................... 60
- Using the Column Menu for Reports ......................................................... 60
- Using Sort Column Indicators in Your Report ............................................ 65
- Formatting Interactive Reports from the Column Menu .............................. 66
- Creating Content Using the Chart Rollup Tool .......................................... 70
- Using Sort Column Indicators to Control the Display of Information in Your Report .......................................................... 72
- Creating a Report with In-Document Analytics ............................................ 73
- Creating an In-Document Analytics Report.................................................. 76
  - In-Document Analytics Report Menu Options ............................................ 76
  - In-Document Analytics Cell Menu Options .............................................. 81
- Configuring In-Document Analytics Report Options .................................... 82
  - General Tab ................................................................................. 82
  - Menu Options Tab ......................................................................... 83
  - Colors Tab .................................................................................. 85
  - Advanced Tab ............................................................................. 86
- Creating an In-Document Analytics Enabled Chart ....................................... 86
  - In-Document Analytics Options for Charts .............................................. 87
  - Usage Notes for In-Document Analytics Enabled Charts ............................ 90
- Creating a Chart with In-Document Analytics ............................................. 90
  - In-Document Analytics Options for Charts .............................................. 93
    - Working With Charts Using the Chart Rollup Tool .................................. 93
    - Legacy Style Chart Options ............................................................... 94
- Creating Content Using the Chart Rollup Tool ............................................. 97
- Creating an In-Document Analytics Enabled Dashboard ................................ 99
  - In-Document Analytics Dashboard Prompts ............................................ 99
  - Target Reports ............................................................................... 100
  - Using Multiple Reports as Targets and Sources ....................................... 101

### 3. In-Document Analytics for Mobile Web Apps ........................................ 109
- Requirements for Mobile Web Apps .......................................................... 109
- Mobile and Tablet Device Support Information .......................................... 109
- Mobile Web Apps Features ....................................................................... 110
- Standard Gesture Support ......................................................................... 110
Running an In-Document Analytics Report on a Mobile Device .................................................... 113
Adjusting the Views. ....................................................................................................................... 115
Adding an In-Document Analytics Report or Dashboard to the Home Screen. .................. 115
Hiding and Showing the Pagination Bar and the Top and Bottom Toolbars. ............... 116
Navigating Between Pages. .......................................................................................................... 116
Accessing the Report Column Drop-Down Menu. ............................................................... 117
Sorting Data. ................................................................................................................................. 119
Filtering Data. ............................................................................................................................... 119
Using the Filter Tab. ...................................................................................................................... 121
Calculating Data. .......................................................................................................................... 121
Viewing Data as a Chart. .............................................................................................................. 123
Using the In-Document Analytics Chart Menu. ........................................................................ 128
Viewing Data in a Rollup Table. .................................................................................................. 131
Using the Rollup Tab. .................................................................................................................... 134
Using the Rollup Menu. ................................................................................................................. 137
Viewing Data in a Pivot Table. ..................................................................................................... 142
Using the Pivot Tab. ...................................................................................................................... 145
Using the Pivot Menu. .................................................................................................................... 146
Using Data Visualization. ............................................................................................................. 149
Hiding or Restoring a Column. .................................................................................................... 149
Freezing or Unfreezing a Column. ............................................................................................. 150
Controlling the Number of Records Per Page. ......................................................................... 150
Restoring a Report to Its Original State. .................................................................................. 151
Unsupported Menu Options. ......................................................................................................... 151
Running an In-Document Analytics Dashboard on a Mobile Device ....................................... 153

4. Designing Your Applications With WebFOCUS Syntax ......................................................... 155
Controlling the In-Document Analytics Cache ........................................................................ 155
Suppressing the Display of the Filter Options in a Tooltip .................................................. 158
Styling the Filter Selection Dialog Box ...................................................................................... 159
Implementing Cascading Multi Drill .......................................................................................... 162
Customizing the Page Range on the Pagination Bar ................................................................. 164
Preface

This content describes how to use and work with In-Document Analytics. It is intended for administrators and developers who are responsible for creating reports, using interactive reports to create dashboards, and creating reports for Adobe® Flash® Player and for PDF.

The WebFOCUS® tool set generates the rich FOCUS® fourth generation language. While this language is very extensive, the WebFOCUS tool set supports only a subset of the language and only specific syntax constructs. While you can manually modify the content of these WebFOCUS procedures and files, there is no guarantee that you will be able to open the modified procedure in the tool.

How This Manual Is Organized

This manual includes the following chapters:

<table>
<thead>
<tr>
<th>Chapter/Appendix</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Using In-Document Analytics</td>
</tr>
<tr>
<td>2</td>
<td>Creating Interactive Content With In-Document Analytics</td>
</tr>
<tr>
<td>3</td>
<td>In-Document Analytics for Mobile Web Apps</td>
</tr>
<tr>
<td>4</td>
<td>Designing Your Applications With WebFOCUS Syntax</td>
</tr>
</tbody>
</table>

Conventions

The following table describes the conventions that are used in this manual.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>THIS TYPEFACE</td>
<td>Denotes syntax that you must enter exactly as shown.</td>
</tr>
<tr>
<td>or</td>
<td></td>
</tr>
<tr>
<td>this typeface</td>
<td></td>
</tr>
<tr>
<td>Convention</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td><em>this typeface</em></td>
<td>Represents a placeholder (or variable) in syntax for a value that you or the system must supply.</td>
</tr>
<tr>
<td>underscore</td>
<td>Indicates a default setting.</td>
</tr>
<tr>
<td><em>this typeface</em></td>
<td>Represents a placeholder (or variable), a cross-reference, or an important term. It may also indicate a button, menu item, or dialog box option that you can click or select.</td>
</tr>
<tr>
<td>Key + Key</td>
<td>Indicates keys that you must press simultaneously.</td>
</tr>
<tr>
<td>{ }</td>
<td>Indicates two or three choices. Type one of them, not the braces.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Indicates a group of optional parameters. None are required, but you may select one of them. Type only the parameter in the brackets, not the brackets.</td>
</tr>
<tr>
<td></td>
<td>Separates mutually exclusive choices in syntax. Type one of them, not the symbol.</td>
</tr>
<tr>
<td>...</td>
<td>Indicates that you can enter a parameter multiple times. Type only the parameter, not the ellipsis (...).</td>
</tr>
<tr>
<td>. . .</td>
<td>Indicates that there are (or could be) intervening or additional commands.</td>
</tr>
</tbody>
</table>

**Related Publications**

Visit our Technical Content Library at [http://documentation.informationbuilders.com](http://documentation.informationbuilders.com). You can also contact the Publications Order Department at (800) 969-4636.

**Customer Support**

Do you have questions about this product?
Join the Focal Point community. Focal Point is our online developer center and more than a message board. It is an interactive network of more than 3,000 developers from almost every profession and industry, collaborating on solutions and sharing tips and techniques. Access Focal Point at [http://forums.informationbuilders.com/eve/forums](http://forums.informationbuilders.com/eve/forums).

You can also access support services electronically, 24 hours a day, with InfoResponse Online. InfoResponse Online is accessible through our website, [http://www.informationbuilders.com](http://www.informationbuilders.com). It connects you to the tracking system and known-problem database at the Information Builders support center. Registered users can open, update, and view the status of cases in the tracking system and read descriptions of reported software issues. New users can register immediately for this service. The technical support section of [http://www.informationbuilders.com](http://www.informationbuilders.com) also provides usage techniques, diagnostic tips, and answers to frequently asked questions.

Call Information Builders Customer Support Services (CSS) at (800) 736-6130 or (212) 736-6130. Customer Support Consultants are available Monday through Friday between 8:00 a.m. and 8:00 p.m. EST to address all your questions. Information Builders consultants can also give you general guidance regarding product capabilities. Please be ready to provide your six-digit site code number (xxxx.xx) when you call.

To learn about the full range of available support services, ask your Information Builders representative about InfoResponse Online, or call (800) 969-INFO.

**Information You Should Have**

To help our consultants answer your questions effectively, be prepared to provide the following information when you call:

- Your six-digit site code (xxxx.xx).
- Your WebFOCUS configuration:
  - The front-end software you are using, including vendor and release.
  - The communications protocol (for example, TCP/IP or HLLAPI), including vendor and release.
  - The software release.
  - Your server version and release. You can find this information using the Version option in the Web Console.
  - The stored procedure (preferably with line numbers) or SQL statements being used in server access.
The Master File and Access File.

The exact nature of the problem:

- Are the results or the format incorrect? Are the text or calculations missing or misplaced?
- Provide the error message and return code, if applicable.
- Is this related to any other problem?

- Has the procedure or query ever worked in its present form? Has it been changed recently? How often does the problem occur?

- What release of the operating system are you using? Has it, your security system, communications protocol, or front-end software changed?

- Is this problem reproducible? If so, how?

- Have you tried to reproduce your problem in the simplest form possible? For example, if you are having problems joining two data sources, have you tried executing a query containing just the code to access the data source?

- Do you have a trace file?

- How is the problem affecting your business? Is it halting development or production? Do you just have questions about functionality or documentation?

User Feedback

In an effort to produce effective documentation, the Technical Content Management staff welcomes your opinions regarding this document. You can contact us through our website, http://documentation.informationbuilders.com/connections.asp.

Thank you, in advance, for your comments.

Information Builders Consulting and Training

Interested in training? Information Builders Education Department offers a wide variety of training courses for this and other Information Builders products.

For information on course descriptions, locations, and dates, or to register for classes, visit our website (http://education.informationbuilders.com) or call (800) 969-INFO to speak to an Education Representative.
Chapter 1

Using In-Document Analytics

This topic provides an overview of In-Document Analytics, introducing you to the basics of viewing reports, charts, and dashboards in an offline environment.

This topic also describes the features of an In-Document Analytics report, which is a report that is enabled to use the full capabilities of In-Document Analytics. An In-Document Analytics report is also called an interactive report.

In this chapter:

- In-Document Analytics Reports Overview

In-Document Analytics Reports Overview

An interactive report is a report that is designed for offline analysis. When using an interactive report, you can:

- Interact with the data, using analysis options similar to those found in an Excel® workbook, without any connection to a server. Analysis options include filtering, sorting, charting, and much more.

- Work offline without any additional plug-ins or programs. An interactive report is a self-contained report, meaning that it contains all the data and JavaScript® within the HTML output file. Packaging the data and the interactive functions in the HTML file also makes the output highly compressible for email and transparent to security systems.

- Save the report on a local machine with interactive report functionality. Since no connection to a server is required to view the data or use the analysis options, you can save and use the report anywhere.

Note: Performance may vary across browsers due to browser-specific memory limitations. For very large reports, Internet Explorer® may produce an error. For more information, refer to the Microsoft® website.

An interactive report for Adobe Flash Player includes most of the capabilities available in the HTML version of active reports in a visually enhanced, user-friendly report format. An interactive report delivered as a self-contained Adobe Flash SWF file that is Adobe Flash Player compatible allows for faster analysis of large data sets and interaction with the interactive report.
When working with an interactive report, you can:

- Filter or highlight data.
- Sort data within any column in ascending or descending order.
- Apply calculations to columns and choose the location at which to display results.
- Control the display of data by hiding columns, freezing columns, limiting the number of rows per page, and using graphic visualization to compare column values.
- Create a variety of simple or advanced charts (pie, line, bar, or scatter) and Rollup Tables.
- Apply a global filter to multiple reports within the same HTML page.
- Export report data and chart data.
- Restore original report settings.
- Run interactive reports on your mobile device with the Opera™ browser (Version 8.60 U2 or higher) installed. See the Opera website for a list of supported devices.
- Run interactive reports on your iPhone® mobile device. For the best performance results, it is recommended that you set a maximum of 500 records for a mobile report.

Some interactive report functionality is drag and drop based, and thus not supported with iPhone.
The following image shows an AHTML interactive report. The Column menu that displays is for Gross Profit.

![AHTML Interactive Report Example](image-url)

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Sum</th>
<th>Gross Profit</th>
<th>Cost of Goods</th>
<th>Discount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Streaming</td>
<td>$1,959,599.85</td>
<td>$5,904,730.00</td>
<td>$3,945,599.84</td>
<td></td>
</tr>
<tr>
<td>Stereo Systems</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Boom Box</td>
<td>$546,423.99</td>
<td>$840,373.00</td>
<td>$62,739.39</td>
<td></td>
</tr>
<tr>
<td>Home Theater Systems</td>
<td>$27,931,096.22</td>
<td>$66,420,589.00</td>
<td>$3,943,920.23</td>
<td></td>
</tr>
<tr>
<td>Receivers</td>
<td>$16,555,835.56</td>
<td>$40,329,688.00</td>
<td>$2,643,045.39</td>
<td></td>
</tr>
<tr>
<td>Speaker Kits</td>
<td>$25,819,241.69</td>
<td>$91,396,140.00</td>
<td>$4,954,243.27</td>
<td></td>
</tr>
<tr>
<td>iPod Docking Station</td>
<td>$15,328,473.06</td>
<td>$26,119,093.00</td>
<td>$1,926,925.29</td>
<td></td>
</tr>
<tr>
<td>Televisions</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CRT TV</td>
<td>$602,419.05</td>
<td>$1,928,416.00</td>
<td>$118,054.08</td>
<td></td>
</tr>
<tr>
<td>Flat Panel TV</td>
<td>$15,885,496.71</td>
<td>$50,077,345.00</td>
<td>$3,478,826.52</td>
<td></td>
</tr>
<tr>
<td>Portable TV</td>
<td>$342,105.45</td>
<td>$545,348.00</td>
<td>$30,210.18</td>
<td></td>
</tr>
<tr>
<td>Video Production</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Editing</td>
<td>$17,947,610.62</td>
<td>$40,105,857.00</td>
<td>$2,606,890.76</td>
<td></td>
</tr>
</tbody>
</table>

21 of 21 records, Page 1 of 1
The following image shows the options that are available at the cell level for an interactive report, including Highlight Value, Highlight Row, Unhighlight All, and Filter Cell. You can also see the hyperlinks that are created for the Auto Drill, Multi Drill, and Auto Linking functionality. The applicable documentation for your graphical tool contains more information on that functionality.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Gross Profit</th>
<th>Cost of Goods</th>
<th>Discount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Charger</td>
<td>$1,970,123.91</td>
<td>$2,052,711.00</td>
<td>$187,498.88</td>
</tr>
<tr>
<td></td>
<td>Headphones</td>
<td>$24,523,023.97</td>
<td>$51,063,564.00</td>
<td>$3,510,913.33</td>
</tr>
<tr>
<td>Camcorder</td>
<td>Universal Remote Controls</td>
<td>7,623.00</td>
<td>$2,310,440.31</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Handheld</td>
<td>$9,016.00</td>
<td>$1,059,024.25</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Professional</td>
<td>$3,308.00</td>
<td>$1,933,097.25</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Standard</td>
<td>1,633.00</td>
<td>$3,214,786.74</td>
<td></td>
</tr>
<tr>
<td>Computers</td>
<td>Smartphone</td>
<td>7,774.00</td>
<td>$2,790,775.51</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tablet</td>
<td>1,890.00</td>
<td>$2,010,134.59</td>
<td></td>
</tr>
<tr>
<td>Media Player</td>
<td>Blu Ray</td>
<td>2,921.00</td>
<td>$10,895,633.29</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DVD Players</td>
<td>9,929,254.00</td>
<td>$25,593.13</td>
<td></td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>DVD Players - Portable</td>
<td>265,150.77</td>
<td>$306,576.00</td>
<td>$25,356.05</td>
</tr>
<tr>
<td></td>
<td>Streaming</td>
<td>$1,930,586.65</td>
<td>$5,064,730.00</td>
<td>$338,559.91</td>
</tr>
<tr>
<td></td>
<td>Boom Box</td>
<td>$548,423.00</td>
<td>$940,373.00</td>
<td>$62,739.30</td>
</tr>
<tr>
<td></td>
<td>Home Theater Systems</td>
<td>$27,931,098.22</td>
<td>$56,428,589.00</td>
<td>$3,943,020.23</td>
</tr>
<tr>
<td></td>
<td>Receivers</td>
<td>$18,555,635.56</td>
<td>$40,329,668.00</td>
<td>$2,043,045.39</td>
</tr>
<tr>
<td></td>
<td>Speaker Kits</td>
<td>$25,819,241.69</td>
<td>$81,395,140.00</td>
<td>$4,954,243.27</td>
</tr>
<tr>
<td></td>
<td>iPod Docking Station</td>
<td>$15,328,473.06</td>
<td>$28,119,093.00</td>
<td>$1,926,925.29</td>
</tr>
<tr>
<td>Televisions</td>
<td>CRT TV</td>
<td>602,419.65</td>
<td>$1,328,416.00</td>
<td>$118,654.68</td>
</tr>
<tr>
<td></td>
<td>Flat Panel TV</td>
<td>$15,085,498.71</td>
<td>$59,077,345.00</td>
<td>$3,478,628.52</td>
</tr>
<tr>
<td></td>
<td>Portable TV</td>
<td>$342,105.45</td>
<td>$945,348.00</td>
<td>$33,210.18</td>
</tr>
<tr>
<td>Video Production</td>
<td>Video Editing</td>
<td>$17,947,019.62</td>
<td>$40,105,657.00</td>
<td>$2,095,890.70</td>
</tr>
</tbody>
</table>

**Note:**

- Depending on how your interactive report has been set up, some options may not be available in your report.

- When using interactive reports, it is recommended that you set the system font to display to **normal** to ensure that the menu options display correctly.

- Freeze options are only available when a report does not fit in the current window. Therefore if your report fits in the current window, Freeze options appear grayed out in the menu. If you resize the report, or a column or row extends beyond the proportion of the window, then Freeze options become activated and are available for use.
This content describes how you can enable In-Document Analytics to create interactive reports, charts, or dashboards that users can view and interact with offline.

**In this chapter:**

- Overview of In-Document Analytics
- Enabling In-Document Analytics in InfoAssist
- Developing Interactive Content
- Working With Interactive Content
- Creating a Report with In-Document Analytics
- Creating an In-Document Analytics Enabled Chart
- Creating an In-Document Analytics Enabled Dashboard

**Overview of In-Document Analytics**

Content that uses In-Document Analytics provides users with an interactive interface that allows the generation of real-time, dynamic reports, charts, and dashboards. Its versatility allows you to package a data set with a combination of analytical views, resulting in highly intuitive and interactive self-service business intelligence. This gives you an edge in presentation and analysis, making it easy to develop and share concepts, ideas, and scenarios. An interactive report is a self-contained report, meaning that it contains all the data and JavaScript® within the HTML output file. Packaging the data and the interactive functions in the HTML file also makes the output highly compressible for email and transparent to security systems. If you are working with a larger data set, you can also zip the output files to reduce the file size when sending them through email.

**Note:** You may need to zip interactive content output files to reduce the file size, and send them through your email client.

Your users can explore and interact with your data using various analytical tools such as sorting, filtering, calculations, roll-ups, and pivoting. They can also experiment with different scenarios using various options.
All of the interactive content that you create functions independently of a server, and is portable, making it easy for your users to work with and analyze complex data without requiring the use of an external application, such as Microsoft Excel. With two types of users (developer and end user), the roles in development and delivery of materials are clear. The end user interacts with the content that the developer creates and deploys. They can obtain content without any additional plug-ins or programs should they choose to access your content remotely or offline, independent of a server.

**Note:** Each artifact that you create at run time is given a unique number for easy identification. This number is incremental but not consecutive, and is assigned automatically.

In InfoAssist, there are two output formats that you can use to enable In-Document Analytics functionality: HTML Analytic Document format (formerly known as AHTML) and PDF Analytic Document format (formerly known as APDF). Using Analytical Document format (ADF), you can generate dynamic content and distribute it offline, even when you are disconnected from a browser. When working with the new Designer style, only AHTML format is supported.
Note: These formats are enabled in the Administration Console by your administrator. As a developer, once you have access to these output formats, you can begin generating content that you can distribute across your enterprise. The HTML Analytic Document format, as it appears in InfoAssist, is shown in the following image.
There are also two available styles that you can apply from the Procedure Settings dialog box. If you created interactive content in an earlier release, you can continue to use this style, which is known as Legacy. Legacy provides options like the Chart/Rollup and Pivot tools. An example of legacy style in a report is shown in the following image.

Alternatively, you can use the Designer Style, which currently presents some of the same options, but displays more like a page that you create in WebFOCUS Designer. An example of Designer style in a chart, is shown in the following image.
When you run your content, you can review and continue to develop it using the available menus. For example, when you run a chart, you can select the chart menu to change the type of chart you are showing, as shown in the following image.
To add a new chart or edit your content, you can use the options available from the vertical Ellipsis menu, which is shown in the following image.

When you view your report or chart at full screen, a hamburger menu also displays, as shown in the following image. From this menu, you can exit full screen, save changes, or restore the dashboard.

Interactive content that you create in WebFOCUS, such as reports and charts, are saved as procedures. You can view the code that is stored in the procedure from within InfoAssist, or the Text Editor. When you view the code for interactive content, you will be able to see which style the procedure uses, with the ARVERSION setting. Interactive content using the Legacy Style is ARVERSION=1, while the Designer style is ARVERSION=2.
By default, all new content that you create in InfoAssist uses the Designer style, ARVERSION=2. If you edit an existing item that uses the Legacy style, that style will remain unless you change the ARVERSION to ARVERSION=2. This would reset the content to display in Designer style.

You can also password protect your interactive content to restrict users from viewing it unless they enter a password. Data is encrypted using the 256-bit Advanced Encryption Standard (AES) specification, and the password is used as the key for decrypting and encrypting the data. Therefore, the password is not stored in the interactive content, and you do not need a connection to go back to the server for password verification.

The HTML page, enabled with In-Document Analytic capabilities, contains both the JavaScript and the data for the content so you can interact with the data in a disconnected mode. Internet Explorer detects the JavaScript and issues a warning. If you look at the Internet Explorer warning, it mentions explicitly the detection of interactive content, which is the JavaScript. The same warning appears when pop-ups are blocked in the browser.

Because all post-retrieval processing is performed in the memory of the web browser, interactive content that has In-Document Analytics enabled has a processing limit of approximately 5,000 records or 100 pages of output. Using the cache option, you can send only the first page of content output to the browser and retrieve subsequent pages from a temporary cache on the Web Query Reporting Server. The server also becomes the resource for performing all calculations, sorting, and filtering when caching is enabled. Since caching uses on-demand paging functionality, WebFOCUS Viewer is not supported.

Content with the cache option in the clustered server environment, using Cluster Manager (CLM), will maintain the connection with the WebFOCUSWeb Query Reporting Server on which the temporary cache is created. This enables the retrieval of subsequent pages from the browser, while it is in the same browser session.

**Note:** When working in CACHE OFF mode, in AHTML (or In-Document Analytics) format, you can export to CSV (comma-separated values) format at run time. The file is automatically sent to the Downloads folder, and applies to all browsers.

The caching feature uses a POST instead of a GET in an HTTP request.
You can save interactive content from your web browser to another location, such as your repository or an FTP server. You can also send interactive content by email or by using a distribution list. This sends the interactive report, chart, or dashboard as an email attachment, distributing it to one or more people through email, as an HTML attachment. If you are sending an interactive dashboard that contains one or more reports or charts, you can burst the distribution by defining parameters in ReportCaster, which sends relevant sections of the dashboard and saves each section as a separate file. Whichever way you choose to send your interactive content, you must keep in mind how it will be viewed.

For example, when you send a report as an HTML attachment to email, many client email programs on a mobile device can block the JavaScript in the attachment. A third-party tool, such as the WebFOCUS Mobile app for a mobile device, may be used to correctly view the attachment.

When you create interactive documents that contain more than one report or chart, you can also share the document by setting up a burst distribution by defining parameters in ReportCaster. This functionality distributes relevant sections of the dashboard to individual users you specify, and saves each section to a separate file.

If you try to view an interactive report in a web browser, and JavaScript is blocked or disabled on your web browser, you will receive a message reminding you that JavaScript must be enabled on the browser. If you are using a mobile device, the message directs you to use the WebFOCUS Mobile app. If the app is not installed, you can download it from the App Store® for iOS devices or from the Google Play™ store for Android™ devices. In the message, App Store and Google Play store are hyperlinks to the WebFOCUS Mobile app.

The message is displayed on the Desktop or on a supported mobile device when JavaScript is disabled in a web browser used to open an online or offline report. It is also displayed on the Preview pane or window of an application used to preview the content of an offline report.
Enabling In-Document Analytics in InfoAssist

In InfoAssist, you can create content, including reports, charts, and dashboards that leverage the interactive capabilities of In-Document Analytics. Enabling this option provides your users with the ability to interact with and modify the content you created for their own analysis.

**Note:** If you use the Designer style, you will only be able to select the AHTML output format. APDF can only be used with the Legacy style.

**Procedure:** How to Enable In-Document Analytics in InfoAssist

1. Open InfoAssist.
2. Create a report, chart, or dashboard.

   **Note:** Your administrator must enable these output options in the Administration Console.

4. Run your content.

   Your report, chart, or dashboard now displays with interactive menu options that can be used for end-user analysis. You can change the style of your interactive content from the Procedure Settings dialog box. The two styles available to you are Legacy or Designer Style. Some of the options available from the interactive menu options may change between the styles.

### Developing Interactive Content

This topic describes how you can develop and enhance interactive content that has enabled In-Docum ent Analytics capabilities.

### Interactive Reports

As a developer, you can create effective, useful reports and share them easily using In-Docum ent Analytics for offline analysis.

A report is used to show the intersections of data between rows and columns. Once created, you can style your report, add headers, and footers, and apply other formatting options to make your data stand out. When you have completed creating your report, you enable In-Docum ent Analytics. Using this format, your users can interact with data, using analysis options similar to those found in an Excel workbook. Since no connection to a server is required to view the data or use the analysis options (for example, filtering, charting, and sorting), you can save and use the report anywhere.

**Note:** All reports display with HFREEZE ON, a feature that freezes the headings in your report, in In-Docum ent Analytics.

### Configuring Analytic Document Options for Reports

You can configure analytic document options for interactive reports, including menu options, based on user role, through the Analytic Document Options dialog box.

You can access the dialog box on the Format tab, in the Features group, by clicking the Analytic Document Options button. The button is available when HTML Analytic Document or PDF Analytic Document is selected as the output type.

The Analytic Document Options dialog box contains the following tabs:

- General
Menu Options
Colors
Advanced

General Tab
Use the General tab to set common properties specific to interactive, analytic reports.

The General tab contains the following options:

Display. This area contains options to set the window to cascade or tabs, and options to freeze columns.

Window. Select the window setting. The options are Cascade and Tabs.

Freeze Columns. Select the columns you would like to freeze. You can also select None.

Page Options. This area contains options to set the number of records per page, enable the display of page information, edit the alignment, and set the location of the page information.

Records Per Page. Select or type the number of records that you would like to display per page. The default value is 57.

Display Page Information. Select this option to display page navigation information. Clear this option to disable the display of page navigation information.

Alignment. Click the appropriate button to set the alignment of the page navigation information. Options are Left, Center, and Right.

Location. Select the location for the page navigation information. The options are Top Row and Bottom Row.

Chart Options. This area contains options that pertain to charts when the output format is PDF Analytic Document.

Note: Chart Options do not display when the output format is HTML Analytic Document.

Legend (check box). Select this option to collapse the legend if necessary. Clear this option if you do not want the legend to collapse.

Legend (menu). Select the location for the legend. The choices are:

- Bottom Left
- Bottom Center
Menu Options Tab

Use the Menu Options tab to select a user type and which options to display in the menu.

The Menu Options tab contains the following options:

- **User Type.** The options are Power, Analyst, Basic, and Custom.
  - **Power.** This is the default user type. It enables all functionality.
  - **Analyst.** This user type has the following functionality: Show Records, Freeze, Hide/Unhide, Export, Sorting, Pivot, Filter, Calculations, Chart, Visualize, Restore Original, Save Changes, and Accordion.
  - **Basic.** This user type has the following functionality: Show Records, Freeze, Hide/Unhide, Sorting, Filter, Calculations, Visualize, and Restore Original.
  - **Custom.** If you select a combination of options that does not match one of the existing user types (Power, Analyst, Basic), the User level name that appears in the User Type field is Custom. This is not a default user type or a selectable user type. It indicates that options for this user do not match any of the existing user types.

The options available according to user type include the following:

- **Show Records.** Shows all records or specific numbers of records.
- **Freeze.** Freezes and unfreezes columns.
- **Hide/Unhide.** Hides and shows columns.
- **Export.** Exports data to HTML, CSV, Excel, or PDF if cache is enabled, or to HTML, CSV, or XML (Excel) if cache is disabled.
- **Sorting.** Sorts data in ascending or descending order.
- **Pivot.** Lists the fields available to create a Pivot table.
- **Window Type.** Shows windows as cascade or tabs.
- **Send as Email.** Enables you to save the current changes and send a report as email.
- **Print.** Prints all records or filtered-only records.
- **Advanced Tools.** Accesses the Chart/Rollup, Pivot, and Grid Tools.
- **Filter.** Opens the Filter Selection dialog box.
Calculations. Performs the following calculations: Sum, Avg, Min, Max, Count, Distinct, % of Total.

Chart. Converts a report to a pie, line, bar, or scatter chart.

Visualize. Adds data visualization bars to a report.

Rollup. Performs rollup on data.

Comments. Adds comments.

Restore Original. Restores the In-Document Analytics enabled report to the default state specified in the report procedure.

Save Changes. Saves the current changes.

Accordion. Produces accordion reports.

Grid Tool. Opens the Grid Tool dialog box.

Colors Tab

Use the Colors tab to select colors for various objects on the report.

The Colors tab contains the following options:

Page. This area contains options to set the colors for the font and background of the page text.

Font. Opens the Color dialog box, where you can select the font color.

Background. Opens the Color dialog box, where you can select the background color for the page text.

Row Selection. This area contains options to set the colors that appear when you point to or select a row on the report.

Hover. Opens the Color dialog box, where you can select the color that the row becomes when you hold the mouse over the row.

Selected. Opens the Color dialog box, where you can select the highlight color that the row becomes when you use the highlight option.

Visual. This area contains options to set the colors for the data visualization bars.

Positive. Opens the Color dialog box, where you can select the color for a data visualization bar that represents a positive number.
- **Negative.** Opens the Color dialog box, where you can select the color for a data visualization bar that represents a negative number.

**Calculations.** This area contains options to set the colors for values in a calculation.

- **Font.** Opens the Color dialog box, where you can select the font color for the calculation.

- **Background.** Opens the Color dialog box, where you can select the background color for the calculation.

**Menu.** This area contains options to change the color of the menu.

- **Normal**
  - **Font.** Opens the Color dialog box, where you can select the color for the text of the options on the column menus.

  - **Background.** Opens the Color dialog box, where you can select the background color for the column menus.

  - **Border.** Opens the Color dialog box, where you can select the color for the border of the column menus.

- **Hover**
  - **Font.** Opens the Color dialog box, where you can select the color for the text of the options on the column menus when you point to them.

  - **Background.** Opens the Color dialog box, where you can select the background color that appears behind options on the column menus when you point to them.

**Advanced Tab**

**Note:** Cache is enabled when you select *HTML Analytic Document* as the output type, and click *Pages On Demand* on the Format tab, in the Navigation group.

The Advanced tab contains the following options:

- **Cache.** Enables a report to cache the data in a binary file and return the data to the output window in pre-set increments.

- **Rows Retrieved.** Select the number of rows retrieved in the output. The default value is 100.

- **Security.** This area allows you to set a password to access the report and enable expiration by date or by days. This option is only available for the reports that have enabled an In-Document Analytics report output.
Note: When setting security options for interactive reports, be aware that security options can be set for each individual component on the canvas, but only one password can be set for the entire document.

Freezing Column Headings in Interactive Reports

When working with interactive reports that use In-Document Analytics, you can freeze column headings. The Freeze option in the GUI tools allows you to define a scroll area within the data of your report and lock the column heading titles in place, enabling you to scroll through the data within the container. Report headings, footings, and grand totals are also locked, so that these also stay in view while you scroll the data in your report. This is particularly useful when you are creating a large report, for which there may be multiple pages.

When you enable the column title freeze feature and run your report, a thin scroll bar displays to the right side of the report, as shown in the following image.
When you mouse over the thin scroll bar, it turns into a full scroll bar, making it easier to scroll through your report data. This scroll bar is shown in the following image.

![Scroll Bar Example](image)

### Scroll Bar Example

<table>
<thead>
<tr>
<th>Customer State</th>
<th>Cost of Goods</th>
<th>Discount</th>
<th>Gross Profit</th>
<th>Revenue</th>
<th>MSRP</th>
<th>TOTAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aargau</td>
<td>$6,507.745</td>
<td>$200.49</td>
<td>$2,204.42</td>
<td>$999.71</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Abruzzo</td>
<td>$3,194.00</td>
<td>$200.20</td>
<td>$1,194.23</td>
<td>$994.23</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Andorra</td>
<td>$4,907.00</td>
<td>$224.64</td>
<td>$1,924.36</td>
<td>$924.36</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Aosta</td>
<td>$5,697.00</td>
<td>$3,228.30</td>
<td>$3,478.51</td>
<td>$1,678.51</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Aland</td>
<td>$1,222,807</td>
<td>$6,814.96</td>
<td>$37,605.50</td>
<td>$13,573.50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Almaty</td>
<td>$2,324.00</td>
<td>$889.38</td>
<td>$1,434.62</td>
<td>$734.62</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Albury</td>
<td>$1,413.00</td>
<td>$1,181.96</td>
<td>$6,065.42</td>
<td>$2,019.42</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Almatykarachar</td>
<td>$9,506.00</td>
<td>$444.19</td>
<td>$3,746.34</td>
<td>$1,252.34</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Almecanarines</td>
<td>$9,282.00</td>
<td>$5,091.76</td>
<td>$4,245.24</td>
<td>$1,245.24</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Almaty</td>
<td>$6,593.00</td>
<td>$422.59</td>
<td>$2,775.95</td>
<td>$9,398.95</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alrad del General Carlos Ibanez</td>
<td>$162,647.00</td>
<td>$31,203.73</td>
<td>$303,821.52</td>
<td>$22,470.51</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alvar del Orellano del Campo</td>
<td>$14,633.00</td>
<td>$687.59</td>
<td>$6,464.03</td>
<td>$20,197.03</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alzegovis</td>
<td>$3,904.00</td>
<td>$2,598.97</td>
<td>$1,305.02</td>
<td>$44,509.78</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alzegoviz county</td>
<td>$10,501.00</td>
<td>$391.49</td>
<td>$4,054.95</td>
<td>$14,555.95</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alzegoviz</td>
<td>$14,561.00</td>
<td>$265.90</td>
<td>$5,481.55</td>
<td>$19,547.55</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alzegoviz al Akmar</td>
<td>$14,254.00</td>
<td>$1,021.62</td>
<td>$3,795.31</td>
<td>$19,039.31</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alzegoviz al Buhayrash</td>
<td>$3,900.00</td>
<td>$165.00</td>
<td>$1,589.30</td>
<td>$5,498.30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alzegoviz al Eltharis</td>
<td>$3,871.00</td>
<td>$433.40</td>
<td>$2,973.58</td>
<td>$11,344.58</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alzegoviz al Italkulis</td>
<td>$4,225.00</td>
<td>$2,30.55</td>
<td>$1,889.05</td>
<td>$5,832.05</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alzegoviz al Juzh</td>
<td>$7,461.00</td>
<td>$347.00</td>
<td>$2,766.75</td>
<td>$10,227.75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alzegoviz al Juzh</td>
<td>$4,050.00</td>
<td>$164.90</td>
<td>$1,876.94</td>
<td>$5,734.94</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alzegoviz al Juzh</td>
<td>$1,568,341.00</td>
<td>$163,408.19</td>
<td>$2,197,145.77</td>
<td>$3,310,543.78</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alzegoviz</td>
<td>$2,295,250.00</td>
<td>$16,364.54</td>
<td>$1,100,781.01</td>
<td>$340,039.01</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alzegoviz</td>
<td>$5,067,907.00</td>
<td>$337,622.92</td>
<td>$207,441.40</td>
<td>$7,079,348.40</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alberta</td>
<td>$5,989,749.00</td>
<td>$465,031.37</td>
<td>$265,115.26</td>
<td>$8,945,995.26</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alesa</td>
<td>$42,503.00</td>
<td>$2,271.65</td>
<td>$18,212.01</td>
<td>$60,805.01</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amausa</td>
<td>$50,453.00</td>
<td>$4,455.82</td>
<td>$37,177.59</td>
<td>$127,639.59</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amiga</td>
<td>$3,966.00</td>
<td>$1,230.14</td>
<td>$1,213.90</td>
<td>$4,250.14</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amazonas</td>
<td>$45,303.00</td>
<td>$2,405.36</td>
<td>$179,389.61</td>
<td>$63,749.61</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Andalucia Hotel Thalasso</td>
<td>$19,253.00</td>
<td>$1,375.72</td>
<td>$7,065.90</td>
<td>$26,839.90</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Andalucia Isla Vegata</td>
<td>$1,561,730.00</td>
<td>$33,150.56</td>
<td>$255,643.60</td>
<td>$717,715.56</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Andaman &amp; Nicobar Islands</td>
<td>$5,455.00</td>
<td>$393.38</td>
<td>$2,349.37</td>
<td>$7,804.37</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Andorra</td>
<td>$5,406.00</td>
<td>$372.99</td>
<td>$2,082.92</td>
<td>$7,759.92</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Andorra Fideale</td>
<td>$68,570.00</td>
<td>$2,914.62</td>
<td>$33,493.66</td>
<td>$122,219.69</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If your report has more columns than can fit in the output container, you can employ the horizontal scroll bar at the bottom of your report.

**Note:** Scroll bars do not display if there is no scrollable data. Thus, if the data displayed fits the size of the container, scroll bars do not display.

You can enable the column heading freeze feature for interactive reports in the GUI tools using the Freeze button on the Format tab of the ribbon, in the Navigation group. Enabling the Freeze option will add HFREEZE=ON in the stylesheet section of the report procedure, as shown in the following example.

```plaintext
HFREEZE=ON
```
Once you have enabled the column heading freeze feature, you must run your report to view the report with scroll bars.

**Procedure:** How to Freeze Column Titles in Interactive Reports

You can freeze column headings in your interactive reports.

1. Open InfoAssist.
2. Build your report.
3. Set the output format to *HTML Analytic Document*.
4. On the *Format* tab, in the *Navigation* group, click *Freeze*.
5. Run the report to view the frozen column titles.
6. A scroll bar displays, enabling you to scroll through your data, vertically, as shown in the following image.

Note: If you have numerous columns in your report, you can employ the horizontal scroll bar at the bottom of the report.

Interactive Charts

Charts are graphical representations of data, showing trends, tendencies, and even possible predictions. A chart often conveys meaning more clearly and effectively than data displayed in tabular form. Charts show summaries on a higher level, giving you a better view of your most important data.

A chart enables you to visually communicate quantitative information. Using a chart, you can give data a shape and form, and reveal patterns and relationships among many data values. A chart can highlight anomalies that require further investigation.

It is important that you choose a chart that is appropriate for your data. InfoAssist provides a complete chart library of both basic and advanced charts. You can choose from a wide variety of charts to best represent the data that you want to display.

In InfoAssist with In-Document Analytics enabled, you can create an interactive chart, change the type of chart, and run the chart to take advantage of the tools that are available to you for online or offline analysis.
Interactive charts support the use of HTML5 extensions, which are user-supplied, custom chart types that access resources external to Web Query/WebFOCUS. For details on the structure of an extension and the steps for creating your own, as well as the process for adding it to the chart library, see the Adding Your Own Chart Types to the Chart Library chapter in the Creating HTML5 Charts With WebFOCUS Language manual.

If you are working with an AHTML chart that does not have the new chart properties (specifically, non-bucket AHTML charts), you will encounter problems if you change the chart type to one of the following chart types using the Advanced Chart tool at run time:

- Tag Cloud
- Funnel
- Pyramid
- Waterfall
- Histogram
- Radar Line
- Radar Area
- 3D Area

By default, these chart types are hidden in the Advanced Chart tool when the original chart is an AHTML bucket chart. These chart types are available under the following circumstances:

- When the original chart is a non-bucket chart
- When the chart is created from a tabular report

**Interactive Dashboards**

You can create an interactive dashboard by inserting multiple content types, such as reports, charts, images, and text, into a document. It will run any report or chart using the In-Document Analytics output format, even if the report or chart itself is not interactive.

You can also insert interactive prompts into a document to act as filters for the reports and charts on the dashboard, as well as cascading (chaining) prompts to populate them based on the selections from the previous prompts.

The output format of the interactive dashboard must be HTML Analytic Document or PDF Analytic Document in order to add interactive dashboard prompts.
Analytic Document Prompts

The Analytic Document prompts group contains buttons that insert components in your dashboard. This group is only visible when the output format of the dashboard is set to HTML Analytic Document or PDF Analytic Document. You can access these options from the Insert tab, in the Analytic Document Prompts group.

The following are the types of prompts that you can use to apply filters to a dashboard:

- **Drop Down.** Inserts a drop-down prompt placeholder in the upper-left corner of the canvas.
- **List.** Inserts a list prompt placeholder in the upper-left corner of the canvas.
- **Checkbox.** Inserts a check box prompt placeholder in the upper-left corner of the canvas.
- **Radio Button.** Inserts a radio button prompt placeholder in the upper-left corner of the canvas.
- **Text.** Inserts a text area prompt placeholder in the upper-left corner of the canvas.

*Note:* The display of values populated in the prompts is dependent on the data setting. For example, if sample data is turned on, then the prompts will show sample data, such as:

WF_RETAIL1  
WF_RETAIL2  
WF_RETAIL3

Target Reports

When you bind a field to an Analytic Document prompt, the default target report is the report from which you dragged the field. You can add or remove target reports from the prompt through the Analytic Document Options dialog box.

A report must meet one of the following requirements to be a target report:

- The report must contain a field with the same name as the source field (actual field name or AS name).

- The Master File of the report must contain a field with the same name as the source field.

If a report is eligible to be a target report because the field has the same user-supplied title and the title is changed, the report is automatically removed as a target.

*Procedure:* How to Add an Analytic Document Prompt to a Dashboard

This procedure describes how to begin to create a dashboard by creating one report and binding a single prompt to one of the fields of the report.
With InfoAssist in Document mode:

1. On the status bar, in the Output Types menu, accept the default output type, or click .


   A placeholder appears on the canvas.

3. Drag fields onto the canvas, or into the Query pane, to create the report and start building the dashboard.

4. On the Insert tab, in the Analytic Document Prompts group, select a prompt type, such as Drop Down, List, Checkbox, Radio Button, or Text.

   The prompt type you selected now appears in the upper-left corner of the canvas. If the report is located in the upper-left corner of the canvas, you will have to drag the prompt off the report.

5. Select the report and bind one of its data source fields to the prompt in one of the following ways:

   - **Query pane**: Select the report. From the Query pane, drag the field that you want to bind onto the prompt.
   
   - **Report on the canvas**: Click the report on the canvas. You can now edit it. Highlight the column that contains the data that you want and drag it onto the prompt.

   Once you have bound the field to the prompt, the values of the field appear in the prompt.

   **Note**: Once a prompt is added to the canvas, the document is locked in an In-Document Analytics output format, and you cannot change the format. To switch to a non-interactive output format, you must remove all prompts.

### Using Multiple Reports as Targets and Sources

You can add multiple reports and charts to an interactive dashboard. Each report can have multiple prompts associated with it.

**Procedure**: **How to Build a Dashboard With Multiple Reports**

The following procedure describes how to set up Analytic Document Prompts for two reports on a dashboard. In the example that is used, the first report contains information about the categories of electronics products sold in various regions. The Product, Category field will be bound to a group of radio buttons. Each radio button will represent a particular product category of electronics. When you select a radio button for a product category, for example, Accessories, the report will be filtered by your selection.
The second report contains information about the gender and geographic location of electronics consumers. The Gender field will be bound to a drop-down list. The list will display the values, F (female) and M (male). When you select a gender from the drop-down list, the report will be filtered by your selection.

1. Open InfoAssist in Document mode using the wf_retail_lite Master File.
2. Create an interactive dashboard by adding two reports with the following components, respectively:

   **Report 1:**
   - Product, Category
   - Store, Business, Region
   - Discount
   - Gross Profit

   **Report 2:**
   - Gender
   - Customer, Continent
   - Product, Category

3. On the Insert tab, in the Analytic Document Prompts group, add the following prompts to the dashboard, positioning them relative to each respective report.

   - **Radio Button:** This prompt will be used for Report1.
   - **Drop Down:** This prompt will be used for Report2.

4. Right-click the radio button prompt for which you want to bind a field to and click Properties.

   The Analytic Document Prompt Properties dialog box opens.

   The Prompts list displays the two prompts (for example, radiobutton_1 and combobox_2) that were added to the dashboard in Step 3.

5. From the Report drop-down menu, select the report that contains the field to which you want to bind a prompt.
In this example, the radio button list (radiobutton_1) has been selected as the prompt for the region report (Report 1), as shown in the following image.

The next step describes how to bind the Product, Category field from the region report to the radio button list to filter that report.

6. From the Field drop-down menu, select the field to which you want to bind the prompt. In this example, the Product, Category field has been selected for the radio button list (radiobutton_1), as shown in the following image.

**Note:** You can optionally specify an ascending or descending sort order for the current scenario.

7. Click OK.

The prompt is now bound to the field on the dashboard.
In the following image, the radio button list is bound to the Product, Category field. It displays all product categories by which you can filter the report.

The following steps describe how to bind the Gender field in the gender report (Report2) to the drop-down list prompt.

8. Right-click the Drop Down prompt for which you want to bind a field and click Properties.

The Analytic Document Prompt Properties dialog box opens again.

Notice that combobox_2, the prompt selected on the dashboard, is selected in the Prompts list.

9. From the Report drop-down menu, select the report (Report2) that contains the field to which you want to bind a prompt.
The next step describes how to bind the Gender field from the gender report to the drop-down list to filter that report.

10. From the Field drop-down menu, select the field (Gender) to which you want to bind the prompt.

Once the Gender field has been selected, Report2 (gender report) appears in the Targets list and Report1 (region report) appears in the Candidate Reports list.

**Note:** To move a report from the Candidate Reports list box to the Targets list box, select it and click the Add to List arrow. To remove a report from the Targets list box, select it and click the Remove from List arrow. You can select multiple reports by holding down the Ctrl key and clicking each one.

11. Click OK.
The prompt is now bound to the Gender field on the dashboard. You can now filter the gender report by female or male, as shown in the following image.

<table>
<thead>
<tr>
<th>Gender</th>
<th>Customer Continent</th>
<th>Product Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>Africa</td>
<td>Accessories</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Camcorder</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Media Player</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Systems</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Televisions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Video Production</td>
</tr>
<tr>
<td>Asia</td>
<td></td>
<td>Accessories</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Camcorder</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Media Player</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Systems</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Televisions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Video Production</td>
</tr>
<tr>
<td>Europe</td>
<td></td>
<td>Accessories</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Camcorder</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Media Player</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Systems</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Televisions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Video Production</td>
</tr>
<tr>
<td>North America</td>
<td></td>
<td>Accessories</td>
</tr>
</tbody>
</table>
The final dashboard displays, as shown in the following image.

**Procedure:** How to Change the Field

You can change the field to which the prompt is bound.

1. Create an interactive dashboard in Document mode, or open an existing dashboard, and bind a prompt to a field.
2. Right-click the prompt that you want to configure, and click Properties.
3. From the Field menu, select a different field.

   A warning message alerts you that changing the source field for the prompt will remove the existing prompt and any dependent (child) prompts from the cascades.
4. Click OK to close the warning.
5. Click OK to close the Analytic Document Prompt Properties dialog box.

   The prompt is updated with the new source field.

**Procedure:** How to Change the Filter Condition

1. Create an interactive dashboard in Document mode, or open an existing dashboard, and bind a prompt to a field.
2. Right-click the prompt that you want to work with, and from the shortcut menu, select Properties.

   The Analytic Document Prompt Properties dialog box opens.

3. From the Condition drop-down menu, select the filter condition for the prompt. The options are Equal to, Not equal to, Less than, Less than or equal to, Greater than, and Greater than or equal to.

4. Click OK.

   The filter condition is applied to the prompt.

**Procedure: How to Add Multiple Prompts to a Dashboard**

1. Create an interactive dashboard in Document mode, or open an existing dashboard containing at least one report, and add at least two prompts.

2. Bind the fields to prompts that you have added.

**Procedure: How to Cascade Prompts**

When you have more than one prompt on the canvas, you can cascade prompts to populate them based on the selections of the previous prompts. Cascading prompts have a parent-child relationship, in which the parent filters the available options of the child.

A prompt can be the parent of more than one other prompt, but cannot be a child of more than one prompt.

1. Create an interactive dashboard in Document mode, or open an existing dashboard, and bind at least two prompts to fields.

2. Right-click the prompt that you want to configure, and click Properties.

   The Analytic Document Prompt Properties dialog box opens.

3. Click Cascades.

   By default, a cascade named Cascade1 appears in the Cascades section of the Analytic Document Prompt Properties dialog box.

   - You can click the Create a new cascade button to create a new cascade.

   - You can click the Delete selected cascade button to delete the selected cascade.

4. Select the cascade to which you want to add prompts.

5. From the Available Prompts list box, select the prompt that you want to add.

6. Click the Add to List arrow to move the selected prompt to the Selected Prompts list box.
Note: You can remove prompts from the Selected Prompts list box by selecting them and clicking the Remove from List arrow.

7. Add any additional prompts you want to be part of the cascade by repeating steps 5 and 6.

By default, the hierarchy of the prompts is determined by the order in which they are added to the Selected Prompts list. The cascade of the prompts is from top to bottom. The prompts that come first in the Selected Prompts list are the parents of the lower prompts.

8. You can change the hierarchy of the prompts by selecting a prompt in the Selected Prompt list box and clicking the Move Up and Move Down arrows.

9. Click OK.

The cascade is created.

10. Run the report.

Note: If you set up more than one cascade, the cascade that you interact with last is the one that filters the report.

Working With Interactive Content

Using the power and flexibility of In-Document Analytics, you can work with interactive content online or offline (disconnected from any servers) in a unique browser session within your environment. Reports, charts, and dashboards, which are comprised of one or more interactive reports or charts, can be distributed or emailed to you, or accessed from the WebFOCUS Home page. You can interact with these items in an environment that supports discovery and exploration, giving you customized content, delivered right to your desktop or mobile device.

Interactive content is created and distributed in your environment by developers. When this content is saved by the developer with an analytic output format, you can leverage the functionality of In-Document Analytics by creating new reports and charts that show aspects of your data that you otherwise might not notice. For example, you can access interactive content and add reports and charts to maximize your analysis. You can drill through to other reports and charts or utilize the Auto Drill functionality to navigate the hierarchy of your data. You can change the chart type or access other formatting options that are available to you. This gives you the flexibility of analyzing your data in different ways, including the ability to export data right from the interactive component to continue your analysis using tools such as Microsoft Excel and HTML.
Developers share these interactive reports, charts, and dashboards with users for the purpose of analyzing and reviewing data and informational trends. For example, you may receive a report or chart that shows a pattern in your data. You can dive deeper into your analysis by creating new reports or charts from this content, enabling you to view different scenarios as you navigate your interactive content.

The interactivity of the content is supported by standard Graphical User Interface (GUI) options that enable you to perform tasks quickly. For example, the Ellipsis menu offers options for creating new items, as well as printing and exporting. The hamburger menu allows you to return from maximized view. The following tools will enable you to effectively navigate InDocument Analytics interactive content.

You can use the options on the vertical Ellipsis menu to perform some of the basic commands, including Export, as well as other options shown in the following image.

You can use the following options on the Ellipsis menu to alter the component:

- **New**. Creates a new report or chart that is based on the fields that you had selected for the original artifact. If your component is a report, a new report will be created. Similarly, if your component is a chart, a new chart will be added.

- **Edit**. Edits the contents of the existing report or chart. Brings up the Chart tool where you can make alternate selections.

- **Duplicate**. Creates a copy of the existing component, which you can use as a template for creating a contrasting artifact. This item is placed in the Analysis panel where it can be viewed and modified.
**Export.** Exports the underlying data or image for the current component. For reports, you can export in Excel, CSV (comma delimited), and HTML format. For charts, you can export to Excel, CSV (comma delimited), and PNG (image) format.

**Print.** Prints your report or chart through your browser.

**Save Changes.** Saves a copy of your chart output, in its current state, to the Downloads folder on your machine. The default name of the output file is ARhtml.html, and includes a Coordinated Universal Time (UTC) date/time stamp.

**Restore Original.** Returns your report or chart back to its original status.

When you create a new report or chart from an interactive component, it displays in the Analysis panel, where you can interact separately with the new component. This panel appears to the right of the screen. The Analysis panel is shown in the following image.

Using the Analysis panel, you can review unique scenarios as you build them, giving you a broader view of your data by allowing you to compare different outcomes. You can also change chart types and lock and unlock results. This is used in cases where you want to avoid manipulating the result in any way. You can duplicate any of the artifacts in the Analysis panel by clicking **Duplicate** on the Ellipsis menu. This allows you to perform comparative analyses of a specific component by copying an existing artifact. You can also edit artifacts in the Analysis panel by clicking **Edit** on the Ellipsis menu. This opens the Chart tool, where you can modify your selections for the current component.
You can also change the chart type for the original chart or on any new charts that you create, as shown in the following image.

You can develop something progressive for your enterprise using these tools and functionality.

For primary components, as well as those in the Analysis panel, you can maximize your content by clicking the maximize button, as shown in the following image.
When your interface is maximized, you can return to the original view or exit full screen by clicking the hamburger menu, as shown in the following image.

When your interface is not in maximized mode (default), the toolbar has a maximize button, as well as a button to quickly change the chart type, which applies only to a chart component. There is also a vertical Ellipsis menu that allows you to navigate to additional options. These options are shown in the following image.

You can also use sort column indicators when you want to sort data in a report component. You can sort a column in ascending and descending order. When you sort a column, a corresponding indicator appears within the column title, as shown in the following image.
In this example, the Gross Profit data is sorted in ascending order, from lowest to highest. If you click the arrow again, the column sorts in descending order, from highest to lowest. If you click the arrow again, it returns to the default arrow that points in both directions, indicating that no sort has been applied, as shown in the following image.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Cost of Goods</th>
<th>Gross Profit</th>
<th>Revenue</th>
<th>Quantity Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>$99,753,888.00</td>
<td>$39,854,440.53</td>
<td>$129,600,338.53</td>
<td>511,667</td>
</tr>
<tr>
<td>Camcorder</td>
<td>$104,856,857.00</td>
<td>$49,596,845.24</td>
<td>$154,465,702.24</td>
<td>455,244</td>
</tr>
<tr>
<td>Computers</td>
<td>$99,907,664.00</td>
<td>$33,509,818.12</td>
<td>$103,316,482.12</td>
<td>351,777</td>
</tr>
<tr>
<td>Media Player</td>
<td>$190,240,481.00</td>
<td>$55,832,578.36</td>
<td>$246,073,056.36</td>
<td>771,934</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>$205,113,863.00</td>
<td>$85,181,070.52</td>
<td>$291,294,933.52</td>
<td>1,114,332</td>
</tr>
<tr>
<td>Televisions</td>
<td>$81,551,109.00</td>
<td>$16,630,023.81</td>
<td>$73,381,132.81</td>
<td>105,188</td>
</tr>
<tr>
<td>Video Production</td>
<td>$40,105,657.00</td>
<td>$17,947,619.62</td>
<td>$58,053,276.62</td>
<td>199,749</td>
</tr>
</tbody>
</table>

When working with charts, you can change the chart type to see your data differently. For reports, you can use the Column menu to create Chart Rollups or Pivot tables and you can use the Cell menu to highlight items. You can use these options on the initial report, chart, or dashboard that is distributed to you, or from any of the new components in the Analysis panel. If your report developer has enabled the following features, you can also navigate different levels of your data (for example, a hierarchy or another report) using Multi Drill, Auto Drill or Auto Linking. These links appear as blue, underlined hyperlinks when you hover over an area of a chart or select an option from a list, as in the case of a report. These links can be clicked as you are navigating the hierarchy of your data or drilling through to a different item in your interactive content.

The Multi Drill functionality enables the interactive content developer to create multiple drill down links on a data field in a report or chart. This is useful when custom links are beneficial, such as a link to a website, other visualizations, or additional reports. If your interactive content developer has enabled it, Auto Drill lets you navigate through different levels within the dimension hierarchy of your data source. This allows you to review the underlying data for a particular area, and move through the structure of your data source based on your information needs. When working with interactive content, the basic functionality of Auto Drill produces different results. For example, you can use Auto Drill functionality in interactive content to drill up or down within the hierarchies of your data for additional analysis. However, because the interactive content refreshes to display a new report or chart when you drill up or down, any content you create from the Chart Rollup menu will disappear. This also applies to any new content that you create using the New option on the Ellipsis menu in an existing report or chart.
If enabled, Auto Linking makes it easy to connect reports and charts in your development environment, expanding the reporting capabilities of your organization. Using Auto Linking, you can dynamically link HTML reports, interactive reports, and HTML5 charts with a single chart of any format, based on their common sort (BY) fields and parameters referenced in any filters.

When you create new reports and charts from interactive content in a browser session, each new piece of content will be given a unique, sequential identification number that enables you to view and manage what you create. This identification number that displays at the top left of the new report or chart, is incremental, and automatically assigned. However, it may not be consecutive.

In addition, when you are adding new information, for example, multiple reports and charts, into the Analysis panel, you cannot save each instance of your analysis as an end-user. Each session is dedicated to the current analysis only. If any of your artifacts contain multi drill or auto drill links, for example, you can interact with these at run time.

**Procedure:** How to Create a New Report or Chart (as an end user)

1. Click the link or distributed attachment to open the interactive content. Optionally, open the interactive content from the WebFOCUS Home page. The interactive content displays.
2. Click the Ellipsis menu and then click **New**. The Chart Tool opens, as shown in the following image.

3. From the left pane, select the data values that you want to include in the new report by placing them in the relevant field container.
4. Click the check mark, ✓, to close the report or chart to accept the selections and add it to the Analysis panel.
Your new component now appears in the Analysis panel, as shown in the following image.

**Note:** This works the same way for new reports, with a label of Report1, Report2, etc.

**Procedure:** How to Export the Underlying Data (or Image) for a Report or Chart

1. Click the link or distributed attachment to open the interactive content. Optionally, open the interactive content from the WebFOCUS Home page. The interactive content displays.

2. On the Ellipsis menu, click *Export*, as shown in the following image.
3. From the left pane, select an output type for the export, as shown in the following image.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>MSRP</th>
<th>Gross Profit</th>
<th>Cost of Goods</th>
<th>Discount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>135,823,833.37</td>
<td>$39,854,449.53</td>
<td>$88,753,988.00</td>
<td>$6,034,845.52</td>
</tr>
<tr>
<td>Camcorder</td>
<td>181,574,103.08</td>
<td>$48,596,945.24</td>
<td>$104,805,057.00</td>
<td>$7,108,408.27</td>
</tr>
<tr>
<td>Computers</td>
<td>190,125,373.20</td>
<td>$33,506,919.12</td>
<td>$99,907,694.00</td>
<td>$4,909,916.10</td>
</tr>
<tr>
<td>Media Player</td>
<td>257,992,180.88</td>
<td>$55,032,578.36</td>
<td>$190,240,481.00</td>
<td>$11,519,142.41</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>204,825,784.06</td>
<td>$66,181,079.52</td>
<td>$206,113,983.00</td>
<td>$13,530,873.57</td>
</tr>
<tr>
<td>Televisions</td>
<td>92,918,023.33</td>
<td>$16,030,023.01</td>
<td>$91,551,100.00</td>
<td>$2,635,893.39</td>
</tr>
<tr>
<td>Video Production</td>
<td>60,749,181.51</td>
<td>$17,947,619.82</td>
<td>$40,105,657.00</td>
<td>$2,665,066.78</td>
</tr>
</tbody>
</table>

4. Click Export to export the data from the component.
5. In your local drive, open the Downloads folder to locate the downloaded file.
6. Open the file in the relevant application (for example, Microsoft Excel or a browser).

**Interactive Content Usage Considerations**

As you develop or interact with content that uses In-Document Analytics, you should reference the following usage considerations.

The following notes apply to browser support.

- **Active PDF (APDF)** is an In-Document Analytics Legacy style output format. It is not supported in Microsoft Edge®, since APDF requires the Adobe Reader plug-in that supports Flash Player.

- **ActiveX**, a technology from Microsoft, is not supported in Microsoft Edge. Any In-Document Analytics feature that requires the use of ActiveX controls is therefore not available in Microsoft Edge. These include the following, which are accessible in other browsers at run time, using the column drop-down menu on an interactive report:
  - Send as E-mail (supported only in Internet Explorer)
  - Save Changes (supported only in Internet Explorer)
  - Export to XML (Excel) when active cache is disabled

- If you are using a Firefox® browser and you export an AHTML report to Excel, the file extension that displays is incorrect (for example, .xls.xls). You can override this default value using the settings of the browser. Specifically, if you click the Always ask me where to save files radio button, which is located under Options, you will be prompted, upon download, to either open or save the file. You can then provide a name and extension for the file.
The following notes apply to interactive reports.

- At run time, when fields are added to, or removed from, a report that includes drilldowns that pass parameter values, the drilldowns are disabled. This is because the parameter values that are passed may no longer apply.

- If multiple report components with different security passwords are included in an AHTML document, the password for the last report component is used.

- Interactive reports employ left and right cell padding, by default. This enables you to view the report consistently, without the concatenation of any values or spacing issues related to the cell padding. In cases where these settings are not defined in the StyleSheet, the default settings for the left and right cell padding are used.

- By default, the name specified in the Master File displays to identify a column in an ACROSS group on a tabular report that has only one display field. With the following SET command, you can display the title specified in the Master File, instead of the name, to identify the column:

  \texttt{SET ACRSVRBTITL = ON}

  It derives the title from the TITLE attribute in the Master File (for example, TITLE = 'Product ID'). It derives the name from the FIELDNAME or FIELD attribute (for example, FIELD = PCD).

- The Sort Ascending, Sort Descending, and Restore Original options are accessible on a column drop-down menu on a report. When cache is enabled on the report, the Restore Original option does not return the report output to its original state after sorting the data. Instead, you receive the following message: Warning: Original sort could not be determined.

- When using interactive content in Cache Mode, filtering may not work properly if the content contains a text field (for example, TX50). As a workaround, consider using an alphanumeric field (for example, A50).

The following notes apply to interactive charts.

- When working with filters in an AHTML chart, certain filtering options do not display if you have only one column on which to filter and it has a decimal format which includes a decimal point. In this case, the Filter Chart and Exclude from Chart filtering options are not available in the chart tooltip at run time.
As of Release 8.2 Version 02, the new chart attribute syntax has been applied to the following chart types: Dual Bar and Line, Tag Cloud, Streamgraph, Mekko, Funnel, and Pyramid. This process adds additional relevant field containers for these chart types, which can be used to specify fields in a specific area of the chart. For example, Horizontal Axis, Color, and Tooltip are field containers that are part of the new chart attribute syntax.

In InfoAssist, specific field containers display for each chart type. For more information on the underlying syntax used to create each chart type, see Creating HTML5 Charts With WebFOCUS Language.

When you run a chart, the output displays a chart toolbar with a number of options that you can select. These options are represented by icons. The chart toolbar provides an Aggregation icon that allows you to select the aggregation method (that is, the type of calculation, such as Sum or Avg) that will be used on the selected data in the chart.

If you run a chart that does not have a measure field to which an aggregation method can be applied, the Aggregation icon:

- Appears on the chart toolbar, but cannot be selected.
- Displays None as the aggregation method. None is dimmed on the label. It indicates that there will be no aggregation performed on, or applied to, the selected data in the chart.

Once you run the chart with data that applies to an aggregation method, the Aggregation icon is activated. Its label reflects the aggregation method currently in use (for example, Sum).

The new chart attribute syntax has been applied to the following chart types: Dual Bar and Line, Tag Cloud, Streamgraph, Mekko, Funnel, and Pyramid. This process adds additional relevant field containers for these chart types, which can be used to specify fields in a specific area of the chart. For example, Horizontal Axis, Color, and Tooltip are field containers that are part of the new chart attribute syntax.

In InfoAssist, specific field containers display for each chart type.

The following note applies to exporting from content using In-Document Analytics.

- If you create a report that contains ACROSS sort fields, and you attempt to export the data using the Excel, CSV, and XML(Excel) options, the ACROSS column titles and field values are not included in the exported content. The same is true for the report headings and footings.
The following note applies to tools available from your interactive content.

- The comma inclusion edit option is not implemented in Rollup tables and Pivot tables when cache is enabled.

The following note applies when using the Cache option.

- Date-time format fields are not supported.

The following notes apply when using the Export to Excel functionality.

- When using the Export to Excel option while creating and generating a report with cache enabled, the request will be generated in XLSX format, rather than EXL2K. This applies to the following browsers: Microsoft Edge, Internet Explorer, Firefox, and Chrome.

  The export behavior is controlled by the WebFOCUS Reporting Server. When the export is performed, an Office Open XML document is produced, which you can download and save in the required format (the default is .xlsx).

- When using the Export to XML (Excel) option with cache disabled, the export behavior is controlled by the active JavaScript layer. When the export is performed, a Microsoft Office XML document is produced, which you can download and save in the required format (the default is .xls). This applies to the following browsers: Microsoft Edge, Internet Explorer, Firefox, and Chrome.

The following note applies when using mobile devices.

- The Chrome browser "Force enable zoom" Accessibility setting on Android mobile devices overrides a website request to prevent zooming. If this setting is enabled when executing an AHTML report on an Android mobile device using Chrome, it interferes with active report functionality, such as Freeze Column and manual resizing. The Accessibility setting needs to be disabled for reports to be fully functional.

**Running Content in Full-Screen Mode**

When you run interactive content in maximized (full-screen) mode, there are a number of navigational features that you can use. For example, you can change the position of report and chart components in full-screen mode using drag and drop. To drag and drop, simply click the toolbar of any component and, holding the mouse, drag the object to the desired position.

In this mode, output is responsive and automatically adjusts when the width of the window is wider than its height. This is particularly useful when you have a number of components in view. In addition, full-screen mode displays a taskbar at the bottom of the screen, with an item for each report or chart component. The component currently selected on the screen is highlighted in the taskbar.
When switching from one dashboard tab to another, each page reflects the correct components that are currently available on that page. You can use the page taskbar at the bottom of the screen to review the report and chart components on the page.

You can also hide a component in full-screen mode. This enables you to hide a component from display, particularly in cases where that object is not currently needed or is irrelevant. If you wish to bring a hidden component back into view, you can click the corresponding item in the taskbar, as shown in the following image.

In cases where you have spawned components (for example, items created using the chart, pivot, rollup, or duplicate options) in full-screen mode, they are numbered in the page taskbar that corresponds to the table/chart component. The number is shown in the right corner, and an item is appended to the right of it for the spawned component. The number indicates how many components have been spawned from that component item. When you click an item in the taskbar, the window is split to display the spawned components along with the currently displayed components.

You can also drag and drop a component to the left or right of another component (in landscape mode) or above or below another component when working in portrait mode. You can reposition a table/chart component using the left or right arrows in the toolbar. This makes it easy to move just one component to the left or right in a single motion.
Another feature of full-screen mode is the ability to display report and chart components side by side while in full-screen mode. You can click on a component button while holding the Ctrl key to display multiple components at a time on the screen. The screen splits evenly to fit all selected component. If you click an item in the taskbar, the corresponding component is displayed in maximized (full-screen) mode and will occupy the full screen, as shown in the following image.

![Diagram showing full-screen mode with multiple components displayed]

**Using the Ellipsis Menu to Perform Common Tasks**

When working with interactive content that uses the Designer style of In-Document Analytics, the Ellipsis menu contains the most commonly used features. For example, you can easily create a new report or chart from this menu.
The Ellipsis menu is located at the top-right of the user interface, and is indicated by stacked black dots, as shown in the following image.

When the Ellipsis menu is expanded, the following items display:

**New.** Select this option to create a new report or chart. This clears the canvas, allowing for the creation of a new item.

**Edit.** Click to use the Designer panes containing Vertical and Horizontal buckets, for example, to manipulate your data differently.

**Duplicate.** Click to duplicate a report or chart, a feature that enables you to create and work with multiple instances of the same report or chart at the same time.

**Export.** Select this option to export the data for your report, table, or chart. For charts, the supported export options include Data to Excel, CSV, and PNG. For tables, the supported export options include Excel, CSV, and HTML. For reports, you can export all records or filtered-only records. For reports and charts, you can multi-select different export options.

**Note:** If cache is disabled, the output is automatically sent to the Downloads folder. This applies to all interactive outputs, across all browsers, as well as when you are working with a disconnected file for offline analysis.

**Print.** Click to print your current work. You can print a report, table, or chart using the Print option on the Ellipsis menu. When you click Print, the Print dialog displays, allowing you to print your report or chart. For reports and tables, you can specify to print all records or filtered-only records.
**Save Changes.** Saves a copy of your chart output, in its current state, to the Downloads folder on your machine. The default name of the output file is ARhtml.html, and includes a Coordinated Universal Time (UTC) date/time stamp.

**Restore Original.** Enables you to return to the report or chart in its original state.

To close the Ellipsis menu, click it again.

When you have duplicated or created a new report or chart from another one, the Ellipsis menu on the duplicated item displays an option to close your component, as shown in the following image.

![Ellipsis menu](image)

You can also lock or unlock a new component. Located on the toolbar, the Lock / Unlock option locks or freezes the report or chart. If you have multiple reports or charts that have been spawned from another, each individual report or chart will have its own Lock / Unlock option.

**In-Document Analytic Options for Reports**

You can use a variety of menus and options when performing analysis of an interactive report that uses In-Document Analytics. Depending on the style that you use, these options may be different.
Designer Style Report Cell Menu Options

Using the Designer Style interactive report, the cell menu allows you to customize the display of your report, while adding the ability to quickly add filters. The cell menu displays when you click on each cell in a report. This enables you to highlight an individual value or a row or add comments about this individual cell in your report. You can also reverse a previously highlighted aspect. The cell menu is shown in the following image.

The Filter Cell option enables you to filter the report for just that row in the report. For example, if you want to see Accessories, you would click on Accessories in the report to enable the cell menu. In this case, the request returns just the values for Accessories, as shown in the following image.

You can subsequently remove the filter by clicking Remove Cell Filter, as shown in the following image.

This returns the report to its original, unfiltered state.
Legacy Report Cell Menu Options

When you are working in an interactive report, that uses the Legacy style, the following data cell options display.

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drill down</td>
<td>Enables you to drill down one level in the hierarchy of your data source. This option displays for reports that have Auto Drill enabled.</td>
</tr>
<tr>
<td>Drill up</td>
<td>Enables you to drill up one level in the hierarchy of your data source. This option displays for reports that have Auto Drill enabled.</td>
</tr>
<tr>
<td>Restore Original</td>
<td>Restores the report to the default state specified in the report procedure.</td>
</tr>
<tr>
<td>Auto Links</td>
<td>Displays a list of target reports that are linked to the Auto Link enabled report. This option displays for reports that have Auto Linking enabled.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enables you to add comments about data in your report. The result is an annotation that displays when you hover over it at run time.</td>
</tr>
<tr>
<td>Highlight Value</td>
<td>Enables you to highlight a particular value in your report.</td>
</tr>
<tr>
<td>Highlight Row</td>
<td>Applies highlighting to the selected row in your report.</td>
</tr>
<tr>
<td>Unhighlight All</td>
<td>Removes any applied highlighting from values or rows in your report.</td>
</tr>
<tr>
<td>Filter Cell</td>
<td>Enables you to filter the output, showing only a selected row of data.</td>
</tr>
<tr>
<td>Remove Cell Filter</td>
<td>Removes any applied cell filters.</td>
</tr>
</tbody>
</table>

Using the Column Menu for Reports

The column menu displays when you click a column heading in a report. This provides you with access to formatting tools, chart type options, and filters, giving you more control over what displays in your report.
For a non-measure or dimension column, there are three primary sections to the column menu, as shown in the following image.

You can customize each column in your report. For example, you may want to filter on specific product categories while displaying column totals for others. This allows you to create and customize your report column by column.

You can use the following information to identify column menu components as you build your report:

**Ascending.** Sorts the selected column in ascending order.

**Descending.** Sorts the selected column in descending order.

**Show Column Total.** Displays the column total for the currently selected column. Column totals display at the bottom of the report.

**Hide Column.** Hides the currently selected column. This removes the currently selected column from view.

**Chart Rollup.** Select a chart type and, optionally, specify an aggregation other than the default value, Sum. Select a column for which to create the chart and click Create. The chart is created in a separate dialog box, enabling you to interact with the chart using the chart features and options.
Rollup. Use the Rollup option to select an aggregation for the currently selected column. You can also select a Group By value, options for which include the list of different columns in the report. Once you have made your selections, click Create to create the rollup, as shown in the following image.

Pivot. Use the Pivot option to create a cross-tab Pivot table. You can select an aggregation for the currently selected column. Next, specify a column value by which to group the report. Indicate an Across value to create the across values in your table. Click Create to create the pivot table, which displays in the analysis panel, as shown in the following image.

Note: The available group and across values include the dimension column values in your report (for example, Product Category).
**Numeric Slider.** If you are working with a measure value (for example, MSRP), you can use the slider tool to narrow the values you want to display. The slider shows the lowest to highest values in your measure, as shown in the following image.

You can specify a range of values by entering the values into the text boxes. This allows you to specify a range of values for a specific measure. If a value falls outside of the range of the data values, it will be crossed out, indicating that the value is invalid, as shown in the following image.

**Filter.** Use the filter option to narrow the data in your report. The filter option allows you to search on a value, or use the check boxes to select one or more values. You can use the Select option to select all values in your data hierarchy. Click Clear to clear the selected values. Once a filter is in place for a column, you can use the funnel-shaped icon, located next in the column heading, to clear the filter. This icon is shown in the following image.
If you are working with a date field, you can filter on a specific date using the filter control in the column menu. The filter control enables you to filter on a specific date or a range of dates, which you can indicate by holding the Ctrl key and clicking, while indicating the starting and ending dates. The range of dates is highlighted after you make your selection. The calendar filter is shown in the following image.

**Note:** When a calendar filter is specified, you can remove the filter by clicking the *Remove Filter* icon at the top of the date column.

**Highlight.** Select *Highlight* to highlight select components of your report. For example, Camcorder, Media Player, and Stereo Systems are highlighted in the following image.

Once the highlight filter is in place, you can remove it by clicking the *Remove Highlight* filter icon.

For measures, there are two additional options:

- **Visualize.** Adds visualization bars to, or removes them from, the selected column.
% of Total. This is a calculation of the current value against the total for the values in a column. When you click Create, a new column is added, showing the calculated values. These options are shown in the following image.

Using Sort Column Indicators in Your Report

Interactive reports support the use of sort column indicators when you want to sort data in a report. You can sort a column in ascending and descending order, giving you control over the display of information in your report. The indicator that shows how a column has been adjusted by a previous action shows to the right of the column, as shown in the following image.

As shown above, the selected column is sorted in ascending order, where the values in the column are sorted from lowest to highest. If you click the arrow again, the column will be sorted in descending order, where the values are sorted from highest to lowest. If you click the arrow again, it will return to the default arrow that points in both directions, indicating that no sort has been applied.
Formatting Interactive Reports from the Column Menu

The column menu opens when you click a column heading in an interactive report. Here, you can access the formatting tools, chart type options, and filters that enable you to control what displays in your report.

For a non-numeric or dimension column, there are three primary sections to the column menu. These include sorting, charting, and filtering options. These are shown in the following image.

You can customize each column in your report. For example, you may want to filter on specific product categories while displaying column totals for others. This allows you to create and customize your report column by column.

You can use the following information to identify column menu components as you build your report:

**Ascending.** Sorts the report column in ascending order.

**Descending.** Sorts the report column in descending order.

**Show Column Total.** Displays the column total for the currently selected column. Column totals display at the bottom of the report.

**Hide Column.** Hides the currently selected column. This removes the currently selected column from view.

**Chart Rollup.** Enables you to select a chart type and, optionally, specify an aggregation other than the default value, Sum. Select a column for which to create the chart and click Create. The chart is created in a separate dialog box, enabling you to interact with the chart using the chart features and options.
**Rollup.** Allows the use of the Rollup option to select an aggregation for the currently selected column. You can also select a Group By value, options for which include the list of different columns in the report. Once you have made your selections, click *Create* to create the rollup, as shown in the following image.

![Rollup Image]

**Pivot.** Enables you to use the Pivot option to create a cross-tab Pivot table. You can select an aggregation for the currently selected column. Next, specify a column value by which to group the report. Indicate an Across value to create the across values in your table. Click *Create* to create the pivot table, which displays in the analysis panel, as shown in the following image.

![Pivot Image]

The available group and across values include the dimension column values in your report (for example, Product Category).
**Numeric Slider.** Enables you to use the slider tool to narrow the values you want to display if you are working with a measure value (for example, MSRP). The slider shows the lowest to highest values in your measure, as shown in the following image.

You can specify a range of values by entering the values into the text boxes. This allows you to specify a range of values for a specific measure. If a value falls outside of the range of the data values, it will be crossed out, indicating that the value is invalid, as shown in the following image.

**Filter.** Narrows the data in your report using the filtering capability. The filter option allows you to search on a value, or use the check boxes to select one or more values. You can use the **Select** option to select all values in your data hierarchy. Click **Clear** to clear the selected values. Once a filter is in place for a column, you can use the funnel-shaped icon, located next in the column heading, to clear the filter. This icon is shown in the following image.
If you are working with a date field, you can filter on a specific date using the filter control in the column menu. The filter control enables you to filter on a specific date or a range of dates, which you can indicate by holding the Ctrl key and clicking, while indicating the starting and ending dates. The range of dates is highlighted after you make your selection. An example of the calendar filter is shown in the following image.

**Note:** When a calendar filter is specified, you can remove the filter by clicking the Remove Filter icon at the top of the date column.

**Highlight.** Select **Highlight** to highlight select components of your report. For example, Camcorder, Media Player, and Stereo Systems are highlighted in the following image.

Once the highlight filter is in place, you can remove it by clicking the Remove Highlight filter icon.

For measures, there are two additional options:

- **Visualize.** Enables you to add visualization bars to, or removes them from, the selected column.
% of Total. Presents calculation of the current value against the total for the values in a column. When you click Create, a new column is added, showing the calculated values.

These options are shown in the following image.

Creating Content Using the Chart Rollup Tool

You can access the Chart Rollup Tool from the column menu in a Designer Style interactive chart or report enabled. There are three tabs: Chart, Rollup, and Pivot. As you create charts, rollups, or pivot tables, each artifact displays in the analysis panel.

You can use the Chart Rollup Tool to select multiple group fields to generate the chart, rollup or pivot table.

For the Chart tab, you can select a chart type, an aggregation, and a column for the chart, as shown in the following image.

Procedure: How to Use the Chart Tool

1. Create a report with multiple dimensions and measures.
2. Click on the primary dimension.
3. From the Chart Rollup tool, select a chart type.
4. Optionally, add an aggregation for the currently selected dimension.
5. Select a dimension or measure from the field list.
6. Click Create.
The chart displays in the analysis panel. You can interact with the chart in the same way as any other artifact.

For the Rollup, you can perform an aggregation on the current report column. You can also select a Group By value, which lists all columns in the report, as shown in the following image.

Procedure: How to Use the Rollup Tool

1. Create a report with multiple dimensions and measures.
2. Click on the primary dimension.
3. From the Chart Rollup tool, select the Rollup tab.
4. Optionally, select an aggregation to be applied to the selected column.
5. For the Group By field, select a dimension or measure for which to perform the rollup.
6. Click Create.
The Rollup displays in the analysis panel.

For Pivot tables, you can similarly select an aggregation for the currently selected column in the report. You can select from the existing dimensions for the Group By and Across fields, as shown in the following image.
Procedure: How to Use the Pivot Tool

1. Create a report with multiple dimensions and measures.
2. Click on the primary dimension.
3. From the Chart Rollup tool, select the Pivot tab.
4. Optionally, select an aggregation to be applied to the selected column.
5. For the Group By field, select a dimension by which to group the table.
6. For the Across field, select another dimension that will display as an across field.
7. Click Create.

The Pivot table displays in the analysis panel.

Using Sort Column Indicators to Control the Display of Information in Your Report

In-Document Analytics (IDA) reports support the use of sort column indicators when you want to sort data in a report. You can sort a column in ascending and descending order, giving you control over the display of information in your report. The indicator that shows how a column has been adjusted by a previous action shows to the right of the column, as shown in the following image.

As shown above, the selected column is sorted in ascending order, where the values in the column are sorted from lowest to highest. If you click the arrow again, the column will be sorted in descending order, where the values are sorted from highest to lowest. If you click the arrow again, it will return to the default arrow that points in both directions, indicating that no sort has been applied.
Creating a Report with In-Document Analytics

As a developer, you can create effective, useful reports and share them easily using In-Document Analytics (IDA). You can create reports in InfoAssist or App Studio, selecting the In-Document Analytic format to enable sharing and access across your enterprise.

A report is used to show the intersections of data between rows and columns. Once created, you can style your report, add headers, and footers, and apply other formatting options to make your data stand out. When you have completed creating your report, you can set the format of the report to In-Document Analytics to enable distribution and sharing of your report. Using this format, you can interact with data, using analysis options similar to those found in an Excel workbook. Since no connection to a server is required to view the data or use the analysis options (for example, filtering, charting, and sorting), you can save and use the report anywhere.

You can create a report using Report mode in InfoAssist or by using the Report Wizard in App Studio.

**Note:** All reports display with HFREEZE ON, a feature that freezes the headings in your report, in In-Document Analytics.

**Procedure:** How to Create an IDA report in InfoAssist

1. In WebFOCUS Designer, click the InfoAssist tab and then click Report. The Open dialog box appears.

2. From the Open dialog box, select the data source that you want to use, and click Open. The data source that you selected appears in the Data pane of the Resources panel.

3. Drag fields onto the canvas or into the Query pane to begin building your report. A basic report is shown in the following image.

5. Optionally, run the report to verify its contents and accessibility.
6. Save the report to your repository for online or offline access.

**Procedure: How to Create a report in App Studio**

1. Open App Studio.
2. On the Home tab, in the Content group, click Report.
   The Report Wizard opens, as shown in the following image.

3. Click Create Report.
   The Report Wizard - Select Procedure Location window opens.
4. Navigate to where you want to create the new report and click Next.
   The Select Data Source window opens.
5. Choose an application folder in the application folder tree, and select a Master File in the Master Files list. You can select the Use Qualified Path check box if you only want to display the data sources in the application folder and generate a qualified file name reference.
6. Click Finish.
   The Report Canvas and the Procedure View panel open.
7. Double-click fields in the Object Inspector, or drag them onto the canvas to add them to the report, as shown in the following image.


   **Note:** The Field and Appearance tabs appear when you select a data column on the Report canvas.

9. To enable In-Document Analytics format:
   a. Click the Format tab.
   b. Select the *HTML Analytic Document* format.
This enables the Analytic Document Options tab, giving you the ability to set In-
Document Analytic report options.

10. To save your report, click Save on the Quick Access Toolbar, or click Save or Save As from the Application menu.

Your report is now accessible by others in your enterprise, online or offline.

**Creating an In-Document Analytics Report**

An In-Document Analytics enabled report is a self-contained report that is designed for offline analysis.

**Procedure:**  **How to Create an In-Document Analytics Report**

With InfoAssist in Report mode, you can perform this procedure in Query Design view or Live Preview.

1. On the status bar, in the Output Types menu, click *HTML Analytic Document* or *HTML Analytic Document*.

2. Populate the report with your data in one of the following ways:
   - Drag the dimension fields and measure fields onto the canvas.
   - Drag the dimension fields and measure fields into the appropriate field containers in the Query pane.

**In-Document Analytics Report Menu Options**

Menu options for an In-Document Analytics enabled report are described in the following table.

**Note:** The following options described in the table require the use of ActiveX controls. Since Microsoft Edge does not support ActiveX technology, these options are not available in that browser:

- Send as E-mail
- Save Changes
- Export to XML (Excel) when cache is disabled

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort Ascending</td>
<td>Sorts the column in ascending order.</td>
</tr>
<tr>
<td>Sort Descending</td>
<td>Sorts the column in descending order.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>--------</td>
<td>------------</td>
</tr>
<tr>
<td>Filter</td>
<td>Filters the data. Options are:</td>
</tr>
<tr>
<td>☐ Equals</td>
<td></td>
</tr>
<tr>
<td>☐ Not equal</td>
<td></td>
</tr>
<tr>
<td>☐ Greater than</td>
<td></td>
</tr>
<tr>
<td>☐ Greater than or equal to</td>
<td></td>
</tr>
<tr>
<td>☐ Less than</td>
<td></td>
</tr>
<tr>
<td>☐ Less than or equal to</td>
<td></td>
</tr>
<tr>
<td>☐ Between</td>
<td></td>
</tr>
<tr>
<td>☐ Not Between</td>
<td></td>
</tr>
<tr>
<td>☐ Contains</td>
<td></td>
</tr>
<tr>
<td>☐ Contains (match case)</td>
<td></td>
</tr>
<tr>
<td>☐ Omits</td>
<td></td>
</tr>
<tr>
<td>☐ Omits (match case)</td>
<td></td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Definition</strong></td>
</tr>
<tr>
<td>--------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Calculate</td>
<td>Calculation types that you can apply to the column:</td>
</tr>
<tr>
<td></td>
<td>- Clear</td>
</tr>
<tr>
<td></td>
<td>- Clear All</td>
</tr>
<tr>
<td></td>
<td>- Count</td>
</tr>
<tr>
<td></td>
<td>- Distinct, which counts the number of distinct values within a field</td>
</tr>
<tr>
<td></td>
<td>For numeric fields, you can also apply:</td>
</tr>
<tr>
<td></td>
<td>- Sum</td>
</tr>
<tr>
<td></td>
<td>- Avg</td>
</tr>
<tr>
<td></td>
<td>- Min</td>
</tr>
<tr>
<td></td>
<td>- Max</td>
</tr>
<tr>
<td></td>
<td>- Count</td>
</tr>
<tr>
<td></td>
<td>- Distinct, which counts the number of distinct values within a field</td>
</tr>
<tr>
<td></td>
<td>- % of Total</td>
</tr>
<tr>
<td>Chart</td>
<td>Creates an In-Document Analytics enabled chart from the report. Options are Pie, Line, Column, and Scatter.</td>
</tr>
<tr>
<td>Rollup</td>
<td>Lists the fields available to create a table.</td>
</tr>
<tr>
<td>Pivot (Cross Tab)</td>
<td>Lists the fields available to create a Pivot table.</td>
</tr>
<tr>
<td>Visualize</td>
<td>Adds visualization bars to, or removes them from, the selected column. The Visualize option is available for numeric data columns.</td>
</tr>
<tr>
<td>Hide Column</td>
<td>Suppresses the display of the selected column in the report.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Columns</td>
<td>Lists the names of the columns that are hidden in the report, allowing you to individually restore a column. Select the name of a specific column in the hidden columns list to restore that column to the report.</td>
</tr>
<tr>
<td>Freeze Column</td>
<td>Freezes the report at a particular point so that columns to the left of the freeze point remain in view while the user scrolls through the other report columns.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the report can be fully viewed in the browser window, freeze is not applied. The Freeze column option is not available for expandable report (Accordion) views.</td>
</tr>
<tr>
<td>Unfreeze All</td>
<td>Unfreezes the columns.</td>
</tr>
<tr>
<td>Grid Tool</td>
<td>Opens the Grid Tool, which you can use to change the column order, select multiple columns to sort ascending or descending, hide and show columns, add a calculation result to a column, and add subtotals to the In-Document Analytics enabled report.</td>
</tr>
<tr>
<td>Chart/Rollup Tool</td>
<td>Opens the Chart/Rollup Tool, which you can use to select multiple group fields to generate the chart or rollup table. The Chart/Rollup Tool contains a list of columns available in the In-Document Analytics enabled report to add to Group By and Measure fields. Drag the columns into the field that you want.</td>
</tr>
<tr>
<td>Pivot Tool</td>
<td>Opens the Pivot Tool, which you can use to select multiple group fields to generate the chart or pivot table. The Pivot Tool contains a list of columns available in the In-Document Analytics enabled report to add to Group By, Across, and Measure fields. Drag the columns into the field that you want.</td>
</tr>
<tr>
<td>Show Records</td>
<td>Opens the Show Records menu option to list the number of records available for display per page in the report. Select a number (for example, 10) to display, per page. Default displays the number of records (lines) per page that is specified in the WebFOCUS report procedure.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Comments</td>
<td>Options to display comments under cells or hide indicators for comments in the In-Document Analytics enabled report output.</td>
</tr>
<tr>
<td>Send as E-mail</td>
<td>Enables you to save the current state of the In-Document Analytics enabled report and send the report as email.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To use this feature, you must have ActiveX enabled in your browser security settings.</td>
</tr>
<tr>
<td></td>
<td>This feature is only supported in Internet Explorer.</td>
</tr>
<tr>
<td>Save Changes</td>
<td>Saves the current state of the In-Document Analytics enabled report as an HTML file in the Downloads folder.</td>
</tr>
<tr>
<td></td>
<td>Depending on your browser settings, you can optionally save the file to a different location on your local system.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When you save an In-Document Analytics enabled report using the browser Save as option, the report is saved in its original default state.</td>
</tr>
<tr>
<td></td>
<td>In the browser Save as dialog box, we recommend that you select the <strong>Webpage, HTML Only</strong> save option to ensure that the page is saved properly.</td>
</tr>
<tr>
<td>Export</td>
<td>When cache is enabled, exports all records or filtered only records to HTML, CSV, Excel, or PDF.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> cache is enabled on an In-Document Analytics enabled report when you click <strong>Pages On Demand</strong> on the Format tab, in the Navigation group.</td>
</tr>
<tr>
<td></td>
<td>When cache is disabled and with cases where a disconnected file is used for offline analysis, exports all records or filtered only records to HTML, CSV, or XML (Excel) and automatically places a copy in your Downloads folder. This applies to the export of all interactive output across all browsers. To use this feature, you must enable ActiveX in your browser security settings.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints all records or filtered only records.</td>
</tr>
<tr>
<td>Window</td>
<td>Displays reports in a cascade or separate tabs.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Restore Original</td>
<td>Restores the In-Document Analytics enabled report to the default state specified in the report procedure.</td>
</tr>
</tbody>
</table>

**In-Document Analytics Cell Menu Options**

When you are working in In-Document Analytics enabled report format (legacy format), the following data cell options display.

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drill down</td>
<td>Enables you to drill down one level in the hierarchy of your data source. This option displays for reports that have Auto Drill enabled.</td>
</tr>
<tr>
<td>Drill up</td>
<td>Enables you to drill up one level in the hierarchy of your data source. This option displays for reports that have Auto Drill enabled.</td>
</tr>
<tr>
<td>Restore Original</td>
<td>Restores the In-Document Analytics enabled report to the default state specified in the report procedure.</td>
</tr>
<tr>
<td>Auto Links</td>
<td>Displays a list of target reports that are linked to the Auto Link enabled report. This option displays for reports that have Auto Linking enabled.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enables you to add comments about data in your report. The result is an annotation that displays when you hover over it at run time.</td>
</tr>
<tr>
<td>Highlight Value</td>
<td>Enables you to highlight a particular value in your report.</td>
</tr>
<tr>
<td>Highlight Row</td>
<td>Applies highlighting to the selected row in your report.</td>
</tr>
<tr>
<td>Unhighlight All</td>
<td>Removes any applied highlighting from values or rows in your report.</td>
</tr>
<tr>
<td>Filter Cell</td>
<td>Enables you to filter the output, showing only a selected row of data.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Remove Cell Filter</td>
<td>Removes any applied cell filters.</td>
</tr>
</tbody>
</table>

**Configuring In-Document Analytics Report Options**

You can configure In-Document Analytics enabled report options, including menu options, based on user role, through the Analytic Document Options dialog box.

You can access the dialog box on the Format tab, in the Features group, by clicking the *Analytic Options* button. The button is available when HTML Analytic Document or PDF Analytic Document is selected as the output type.

The Analytic Document Options dialog box contains the following tabs:

- **General**
- **Menu Options**
- **Colors**
- **Advanced**

**General Tab**

Use the General tab to set common properties specific to In-Document Analytics enabled reports.

The General tab contains the following options:

- **Display.** This area contains options to set the window to cascade or tabs, and options to freeze columns.

- **Window.** Select the window setting. The options are Cascade and Tabs.

  **Note:** You can use the Cascade or Tabs options to modify how the output window displays. The Tabs option can be used with the Legacy style only.

- **Freeze Columns.** Select the columns you would like to freeze. You can also select None.

- **Page Options.** This area contains options to set the number of records per page, enable the display of page information, edit the alignment, and set the location of the page information.

- **Records Per Page.** Select or type the number of records that you would like to display per page. The default value is 57.
2. Creating Interactive Content With In-Document Analytics

- **Display Page Information.** Select this option to display page navigation information. Clear this option to disable the display of page navigation information.

- **Alignment.** Click the appropriate button to set the alignment of the page navigation information. Options are Left, Center, and Right.

- **Location.** Select the location for the page navigation information. The options are Top Row and Bottom Row.

**Chart Options.** This area contains options that pertain to charts when the output format is PDF Analytic Document.

**Note:** Chart Options do not display when the output format is HTML Analytic Document.

- **Legend (check box).** Select this option to collapse the legend if necessary. Clear this option if you do not want the legend to collapse.

- **Legend (menu).** Select the location for the legend. The choices are:
  - Bottom Left
  - Bottom Center
  - Bottom Right

**Menu Options Tab**

Use the Menu Options tab to select a user type and which options to display in the menu.

The Menu Options tab contains the following options:

- **User Type.** The options are Power, Analyst, Basic, and Custom.
  - **Power.** This is the default user type. It enables all functionality.
  
  - **Analyst.** This user type has the following functionality: Show Records, Freeze, Hide/Unhide, Export, Sorting, Pivot, Filter, Calculations, Chart, Visualize, Restore Original, Save Changes, and Accordion.
  
  - **Basic.** This user type has the following functionality: Show Records, Freeze, Hide/Unhide, Sorting, Filter, Calculations, Visualize, and Restore Original.
  
  - **Custom.** If you select a combination of options that does not match one of the existing user types (Power, Analyst, Basic), the User level name that appears in the User Type field is Custom. This is not a default user type or a selectable user type. It indicates that options for this user do not match any of the existing user types.
The options available according to user type include the following:

- **Show Records.** Shows all records or specific numbers of records.
- **Freeze.** Freezes and unfreezes columns.
- **Hide/Unhide.** Hides and shows columns.
- **Export.** Exports data to HTML, CSV, Excel, or PDF if cache is enabled, or to HTML, CSV, or XML (Excel) if cache is disabled.
  
  **Note:** If cache is disabled, the output is automatically sent to the Downloads folder. This applies to all interactive outputs, across all browsers, as well as when you are working with a disconnected file for offline analysis.

- **Sorting.** Sorts data in ascending or descending order.
- **Pivot.** Lists the fields available to create a Pivot table.
- **Window Type.** Shows windows as cascade or tabs.
- **Send as Email.** Enables you to save the current changes and send a report as email.
- **Print.** Prints all records or filtered-only records.
- **Advanced Tools.** Accesses the Chart/Rollup, Pivot, and Grid Tools.
- **Filter.** Opens the Filter Selection dialog box.
- **Calculations.** Performs the following calculations: Sum, Avg, Min, Max, Count, Distinct, % of Total.
- **Chart.** Converts a report to a pie, line, bar, or scatter chart.
- **Visualize.** Adds data visualization bars to a report.
- **Rollup.** Performs rollup on data.
- **Comments.** Adds comments.
- **Restore Original.** Restores the In-Document Analytics enabled report to the default state specified in the report procedure.
- **Save Changes.** Saves the current changes.
- **Accordion.** Produces accordion reports.
- **Grid Tool.** Opens the Grid Tool dialog box.
Colors Tab

Use the Colors tab to select colors for various objects on the report.

The Colors tab contains the following options:

Page. This area contains options to set the colors for the font and background of the page text.

- Font. Opens the Color dialog box, where you can select the font color.
- Background. Opens the Color dialog box, where you can select the background color for the page text.

Row Selection. This area contains options to set the colors that appear when you point to or select a row on the report.

- Hover. Opens the Color dialog box, where you can select the color that the row becomes when you hold the mouse over the row.
- Selected. Opens the Color dialog box, where you can select the highlight color that the row becomes when you use the highlight option.

Visual. This area contains options to set the colors for the data visualization bars.

- Positive. Opens the Color dialog box, where you can select the color for a data visualization bar that represents a positive number.
- Negative. Opens the Color dialog box, where you can select the color for a data visualization bar that represents a negative number.

Calculations. This area contains options to set the colors for values in a calculation.

- Font. Opens the Color dialog box, where you can select the font color for the calculation.
- Background. Opens the Color dialog box, where you can select the background color for the calculation.

Menu. This area contains options to change the color of the menu.

- Normal
  - Font. Opens the Color dialog box, where you can select the color for the text of the options on the column menus.
  - Background. Opens the Color dialog box, where you can select the background color for the column menus.
Border. Opens the Color dialog box, where you can select the color for the border of the column menus.

Hover

Font. Opens the Color dialog box, where you can select the color for the text of the options on the column menus when you point to them.

Background. Opens the Color dialog box, where you can select the background color that appears behind options on the column menus when you point to them.

Advanced Tab

Note: cache is enabled when you select HTML Analytic Document as the output type, and click Pages On Demand on the Format tab, in the Navigation group.

The Advanced tab contains the following options:

cache. Enables a report to cache the data in a binary file and return the data to the output window in pre-set increments.

Rows Retrieved. Select the number of rows retrieved in the output. The default value is 100.

Security. This area allows you to set a password to access the report and enable expiration by date or by days. This option is only available for the In-Document Analytics enabled report output.

Note: When setting security options for In-Document Analytics enabled reports, be aware that security options can be set for each individual component on the canvas, but only one password can be set for the entire document.

Creating an In-Document Analytics Enabled Chart

An In-Document Analytics enabled chart is a chart that is designed for offline analysis. For more information, see In-Document Analytics Report Overview.

Note: In-Document Analytics supports the use of HTML5 extensions, which are user-supplied, custom chart types that access resources external to Web Query.WebFOCUS. For details on the structure of an extension and the steps for creating your own, as well as the process for adding it to the chart library, see the Adding Your Own Chart Types to the Chart Library chapter in the Creating HTML5 Charts With WebFOCUS Language manual.
**Procedure:** How to Create an In-Document Analytics Enabled Chart

With InfoAssist in Chart mode, you can perform this procedure in Query Design view or Live Preview.

1. On the status bar, in the Output Types menu, click *HTML Analytic Document* or *PDF Analytic Document*.
2. On the *Format* tab, in the *Chart Types* group, click the button of the chart that you want to create. Bar chart is the default.
   
   The chart appears on the canvas.
3. Populate the chart with your data in one of the following ways:
   
   - Drag the dimension fields and measure fields onto the chart.
   - Drag the dimension fields and measure fields into the appropriate field containers in the Query pane.

   The following image shows an HTML5 pie chart that displays the sum of the values in the Quantity Sold field by Product Category.

   ![Pie Chart Image]

**In-Document Analytics Options for Charts**

Options for an In-Document Analytics enabled chart (legacy) are described in the following table.
**Note:** For charts that employ the new attribute syntax, only the following four icons display: More Options, Advanced Chart, Original Chart, and Aggregation. If you have applied a filter, the Remove Filter icon displays.

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>More Options</td>
<td><strong>New.</strong> Creates a new instance of the chart. This option is available only when the chart is created from a column menu on a tabular report.</td>
</tr>
<tr>
<td></td>
<td><strong>Group By (X).</strong> Changes groups by the horizontal sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>Add (Y).</strong> Adds a vertical sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>X-Axis.</strong> Specifies a measure or dimension sort field. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Y-Axis.</strong> Specifies a measure. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Arrange By.</strong> Specifies the marker color. The marker color depends on the field assigned to the color attribute. If no field is assigned to this category, then all of the markers will be the same color. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Export to.</strong> Exports to Excel, Word, or PowerPoint.</td>
</tr>
<tr>
<td></td>
<td><strong>Stacked.</strong> Stacks the risers on top of each other, with the length of each riser representing the data value. Applies to column charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Top.</strong> Displays the top values. Options are Top 3, Top 5, Top 10, and Clear Top. Applies to pie charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Trend.</strong> Draws a trendline and equation label for an individual series. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Chart/Rollup Tool.</strong> Opens the Chart/Rollup Tool, which you can use to select multiple group fields in the chart or rollup table generated. The Chart/Rollup Tool contains a list of columns available in the In-Document Analytics enabled report and Group By and Measure sort fields. Drag the columns into the desired sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When working with the Chart/Rollup Tool for In-Document Analytics enabled charts (specifically those with the new chart attribute syntax), the Series tab is not supported. It is available with charts that are created with tabular reports or stand-alone charts that do not use the new chart attribute syntax.</td>
</tr>
<tr>
<td></td>
<td><strong>Restore Original.</strong> Restores the In-Document Analytics enabled report to the default state specified in the report procedure.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Column</td>
<td>Displays data as a column chart.</td>
</tr>
<tr>
<td>Pie</td>
<td>Displays data as a pie chart.</td>
</tr>
<tr>
<td>Line</td>
<td>Displays data as a line chart.</td>
</tr>
<tr>
<td>Scatter</td>
<td>Displays data as a scatter chart.</td>
</tr>
<tr>
<td>Rollup</td>
<td>Displays the chart as a rollup table.</td>
</tr>
<tr>
<td>Advanced Chart</td>
<td>Opens the Chart/Rollup Tool.</td>
</tr>
<tr>
<td>Original Chart</td>
<td>Restores the In-Document Analytics enabled chart to the chart type specified in the report procedure.</td>
</tr>
<tr>
<td>Lock/Unlock</td>
<td>Freezes the chart or rollup table. You can link or unlink a chart or rollup table to the filters that you have applied in your report using the Freeze Chart or Freeze Rollup icon. The icon indicates whether the report is linked to the filter (Freeze Chart or Freeze Rollup) or not (Unfreeze Chart or Unfreeze Rollup). This option is available only when the chart is created from a column menu on a tabular report.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Applies the following options to a Measure field: Sum, Avg, Min, Max, Count, and Distinct. The default value is Sum.</td>
</tr>
</tbody>
</table>
Creating an In-Document Analytics Enabled Chart

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove Filter</td>
<td>Removes a filter from a chart. You can apply a filter by pointing to or lassoing an area of the chart and then clicking the <em>Filter Chart</em> or <em>Exclude from Chart</em> option from the chart tooltip.</td>
</tr>
</tbody>
</table>

Usage Notes for In-Document Analytics Enabled Charts

If you are working with an AHTML chart that does not have the new chart properties (specifically, non-bucket AHTML charts), you will encounter problems if you change the chart type to one of the following chart types using the Advanced Chart tool at run time:

- Tag Cloud
- Funnel
- Pyramid
- Waterfall
- Histogram
- Radar Line
- Radar Area
- 3D Area

By default, these chart types are hidden in the Advanced Chart tool when the original chart is an AHTML bucket chart. These chart types are available under the following circumstances:

- When the original chart is a non-bucket chart
- When the chart is created from a tabular report

Creating a Chart with In-Document Analytics

Charts are graphical representations of data, showing trends, tendencies, and even possible predictions. A chart often conveys meaning more clearly and effectively than data displayed in tabular form. Charts show summaries on a higher level, giving you a better view of your most important data.

A chart enables you to visually communicate quantitative information. Using a chart, you can give data a shape and form, and reveal patterns and relationships among many data values. A chart can highlight anomalies that require further investigation.
It is important that you choose a chart that is appropriate for your data. Both InfoAssist and App Studio provide a complete chart library of both basic and advanced charts. You can choose from a wide variety of charts to best represent the data that you want to display.

In InfoAssist with In-Document Analytics, you can create a chart, change the type of chart, and run the chart to take advantage of the interactive tools that are available to you.

In App Studio, you can create and edit InfoAssist charts using the Chart canvas. You use the Chart Wizard to create a new chart and set the output format to In-Document Analytics. Once your chart is created, you can run the chart to take advantage of the interactive, run time tools that display.

This topic provides an overview of how to create a chart in InfoAssist and App Studio, with In-Document Analytics enabled.

**Procedure:** How to Create an In-Document Analytics Chart in InfoAssist

1. In WebFOCUS Designer, click the **InfoAssist** tab, and then click **Chart**. The Open dialog box appears.

2. From the Open dialog box, select the data source that you want to use, and click **Open**. The data source that you selected appears in the Data pane of the Resources panel.

   **Note:** The default chart type is a bar chart.

3. Drag fields onto the canvas or into the Query pane to begin building your chart. A basic chart is shown in the following image.

4. Optionally, click the **Format** tab to select a different chart type from the Chart Types group.

5. On the **Home** tab, in the **Format** group, select **HTML Analytic Document**.

6. Save the chart and run it.

The interactive options of In-Document Analytics display, enabling you to use such features as the Chart/Rollup tool, which lets you change the chart type as you work with your data.
Note: In InfoAssist, the In-Document Analytics option defaults to the Legacy version of the tool. You can use the Procedure Settings to set the In-Document Analytics option to Designer Style, which has a different layout than the Legacy version.

Procedure: How to Create an In-Document Analytics Chart in App Studio

1. Open App Studio.
2. On the Home tab, in the Content group, click Chart.
   
   Note: The default charting application for App Studio is InfoAssist.
3. The Chart Wizard opens, as shown in the following image.

![Chart Wizard Image]

4. Click Create Chart to create a chart using the Chart canvas.
   
The Chart Wizard - Choose location for the new chart window opens.
5. Navigate to where you want to create the new chart and click Next.
   
The Select Data Source window opens.
6. Choose an application folder in the application folder tree, and select a Master File.
   
   You can select the Use Qualified Path check box if you want to only display the data sources in the application folder.
7. Click Finish.
   
The Chart canvas opens, showing the InfoAssist interface.
8. Double-click fields in the Data Pane to add them to the chart.
You can use the features and functions on the InfoAssist ribbon to format the chart.

9. To enable the In-Document Analytic format in InfoAssist:
   a. Navigate to the Home tab.
   b. In the Format group, select the HTML Analytic Document format.

10. To save your chart, click the Save button on the App Studio Quick Access Toolbar, or select Save from the Application menu.

Your chart is now accessible by others in your enterprise, online or offline.

11. To run your chart, click the Run button on the App Studio Quick Access Toolbar.

The interactive options of In-Document Analytics are available, at run time.

**Note:** In chart mode through App Studio, the default In-Document Analytics version is the Legacy version. When working with content in InfoAssist directly, you can switch between the Legacy version and the Designer Style, which has similar functionality.

For more information, see the *Active Technologies User’s Guide*, which is available in the WebFOCUS KnowledgeBase.

**In-Document Analytics Options for Charts**

Similar to the options that are available in an interactive report, you can use chart-specific In-Document Analytics menus and options to perform your analysis.

**Working With Charts Using the Chart Rollup Tool**

If you are working with a chart using the Chart Rollup Tool and you subsequently create a new chart, the new chart launches with a metadata tree, buckets, and the chart picker. This look and feel is similar to the common interface of WebFOCUS Designer, as shown in the following image.
The interface loads with the fields that you had originally selected. This makes it easy to select different fields to create different types of charts at run time.

You can drag or double-click items to add items into the buckets. In this way, you can model different scenarios to create a chart that meets the needs of your organization. Once you have selected the fields to include, you can select a chart type from the chart picker, which displays on the right of the interface.

When you are done, click the checkmark, located at the top right of the interface, to apply the specified changes to your chart and return to the original canvas.

You can test out various scenarios and review different results, all within one session.

**Legacy Style Chart Options**

Options for an interactive chart that used the Legacy styling are described in the following table.

**Note:** For charts that employ the new attribute syntax, only the following four icons display: More Options, Advanced Chart, Original Chart, and Aggregation. If you have applied a filter, the Remove Filter icon displays.
<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>More Options</td>
<td><strong>New.</strong> Creates a new instance of the chart. This option is available only when the chart is created from a column menu on a tabular report.</td>
</tr>
<tr>
<td></td>
<td><strong>Group By (X).</strong> Changes groups by the horizontal sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>Add (Y).</strong> Adds a vertical sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>X-Axis.</strong> Specifies a measure or dimension sort field. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Y-Axis.</strong> Specifies a measure. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Arrange By.</strong> Specifies the marker color. The marker color depends on the field assigned to the color attribute. If no field is assigned to this category, then all of the markers will be the same color. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Export to.</strong> Exports to Excel, Word, or PowerPoint.</td>
</tr>
<tr>
<td></td>
<td><strong>Stacked.</strong> Stacks the risers on top of each other, with the length of each riser representing the data value. Applies to column charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Top.</strong> Displays the top values. Options are Top 3, Top 5, Top 10, and Clear Top. Applies to pie charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Trend.</strong> Draws a trendline and equation label for an individual series. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Chart/Rollup Tool.</strong> Opens the Chart/Rollup Tool, which you can use to select multiple group fields in the chart or rollup table generated. The Chart/Rollup Tool contains a list of columns available in the report and Group By and Measure sort fields. Drag the columns into the desired sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When working with the Chart/Rollup Tool for charts (specifically those with the new chart attribute syntax), the Series tab is not supported. It is available with charts that are created with tabular reports or stand-alone charts that do not use the new chart attribute syntax.</td>
</tr>
<tr>
<td></td>
<td><strong>Restore Original.</strong> Restores the report to the default state specified in the report procedure.</td>
</tr>
<tr>
<td>Column</td>
<td>Displays data as a column chart.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pie</td>
<td>Displays data as a pie chart.</td>
</tr>
<tr>
<td>Line</td>
<td>Displays data as a line chart.</td>
</tr>
<tr>
<td>Scatter</td>
<td>Displays data as a scatter chart.</td>
</tr>
<tr>
<td>Rollup</td>
<td>Displays the chart as a rollup table.</td>
</tr>
<tr>
<td>Advanced Chart</td>
<td>Opens the Chart/Rollup Tool.</td>
</tr>
<tr>
<td>Original Chart</td>
<td>Restores the chart to the chart type specified in the report procedure.</td>
</tr>
<tr>
<td>Lock/Unlock</td>
<td>Freezes the chart or rollup table. You can link or unlink a chart or rollup table to the filters that you have applied in your report using the Freeze Chart or Freeze Rollup icon. The icon indicates whether the report is linked to the filter (Freeze Chart or Freeze Rollup) or not (Unfreeze Chart or Unfreeze Rollup). This option is available only when the chart is created from a column menu on a tabular report.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Applies the following options to a Measure field: Sum, Avg, Min, Max, Count, and Distinct. The default value is Sum.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remove Filter</td>
<td>Removes a filter from a chart. You can apply a filter by pointing to or lassoing an area of the chart and then clicking the Filter Chart or Exclude from Chart option from the chart tooltip.</td>
</tr>
</tbody>
</table>

**Creating Content Using the Chart Rollup Tool**

You can access the Chart Rollup Tool from the column menu in a Designer Style interactive chart or report enabled. There are three tabs: Chart, Rollup, and Pivot. As you create charts, rollups, or pivot tables, each artifact displays in the analysis panel.

You can use the Chart Rollup Tool to select multiple group fields to generate the chart, rollup or pivot table.

For the Chart tab, you can select a chart type, an aggregation, and a column for the chart, as shown in the following image.

---

**Procedure: How to Use the Chart Tool**

1. Create a report with multiple dimensions and measures.
2. Click on the primary dimension.
3. From the Chart Rollup tool, select a chart type.
4. Optionally, add an aggregation for the currently selected dimension.
5. Select a dimension or measure from the field list.
6. Click Create.
   The chart displays in the analysis panel. You can interact with the chart in the same way as any other artifact.
For the Rollup, you can perform an aggregation on the current report column. You can also select a Group By value, which lists all columns in the report, as shown in the following image.

**Procedure:** How to Use the Rollup Tool

1. Create a report with multiple dimensions and measures.
2. Click on the primary dimension.
3. From the Chart Rollup tool, select the **Rollup** tab.
4. Optionally, select an aggregation to be applied to the selected column.
5. For the Group By field, select a dimension or measure for which to perform the rollup.
6. Click Create.
   The Rollup displays in the analysis panel.

For Pivot tables, you can similarly select an aggregation for the currently selected column in the report. You can select from the existing dimensions for the Group By and Across fields, as shown in the following image.

**Procedure:** How to Use the Pivot Tool

1. Create a report with multiple dimensions and measures.
2. Click on the primary dimension.
3. From the Chart Rollup tool, select the Pivot tab.
4. Optionally, select an aggregation to be applied to the selected column.
5. For the Group By field, select a dimension by which to group the table.
6. For the Across field, select another dimension that will display as an across field.
7. Click Create.

The Pivot table displays in the analysis panel.

Creating an In-Document Analytics Enabled Dashboard

You can create an In-Document Analytics enabled dashboard by inserting multiple content types, such as reports, charts, images, and text, into a document. An In-Document Analytics enabled dashboard will run any report or chart using the In-Document Analytics enabled output format, even if the report or chart itself is not in In-Document Analytics enabled output format.

You can also insert In-Document Analytics enabled dashboard prompts into a document to act as filters for the reports and charts on the dashboard. You can cascade (chain) prompts to populate them based on the selections from the previous prompts.

The output format of the active dashboard must be HTML Analytic Document or PDF Analytic Document in order to add In-Document Analytics enabled dashboard prompts.

In-Document Analytics Dashboard Prompts

The Analytic Document prompts group contains buttons that insert In-Document Analytics enabled dashboard prompts into your dashboard. This group is only visible when the output format of the dashboard is set to HTML Analytic Document or PDF Analytic Document. You can access the In-Document Analytics enabled dashboard prompts on the Insert tab, in the Analytic Document prompts group.

The following are the types of In-Document Analytics enabled dashboard prompts that you can use to apply filters to an In-Document Analytics enabled dashboard:

- **Drop Down.** Inserts a drop down prompt placeholder in the upper-left corner of the canvas.
- **List.** Inserts a list prompt placeholder in the upper-left corner of the canvas.
- **Checkbox.** Inserts a check box prompt placeholder in the upper-left corner of the canvas.
- **Radio Button.** Inserts a radio button prompt placeholder in the upper-left corner of the canvas.
- **Text.** Inserts a text area prompt placeholder in the upper-left corner of the canvas.
**Note:** The display of values populated in In-Document Analytics enabled dashboard prompts is dependent on the data setting. For example, if sample data is turned on, then In-Document Analytics enabled dashboard prompts will show sample data, such as:

WF_RETAIL1
WF_RETAIL2
WF_RETAIL3

**Target Reports**

When you bind a field to an analytic document prompt, the default target report is the report from which you dragged the field. You can add or remove target reports from an analytic document prompt through the analytic document properties dialog box.

A report must meet one of the following requirements to be a target report:

- The report must contain a field with the same name as the source field (actual field name or AS name).
- The Master File of the report must contain a field with the same name as the source field.

If a report is eligible to be a target report because the field has the same user-supplied title and the title is changed, the report is automatically removed as a target.

**Procedure:** How to Add an In-Document Analytics Dashboard Prompt to a Dashboard

This procedure describes how to begin to create a dashboard by creating one report and binding a single prompt to one of the fields of the report.

With InfoAssist in Document mode:

1. On the status bar, in the Output Types menu, accept the default output type, or click PDF Analytic Document.

   A placeholder appears on the canvas.
3. Drag fields onto the canvas, or into the Query pane, to create the report and start building the dashboard.
4. On the Insert tab, in the analytic document prompts group, select a dashboard prompt to insert into the document.

   An analytic document prompt appears in the upper-left corner of the canvas. If the report is located in the upper-left corner of the canvas, you will have to drag the prompt off the report.
5. Select the report and bind one of its data source fields to the prompt in one of the following ways:

- **Query pane**: Select the report. From the Query pane, drag the field that you want to bind onto the prompt.

- **Report on the canvas**: Click the report on the canvas. You can now edit it. Highlight the column that contains the data that you want and drag it onto the prompt.

Once you have bound the field to the prompt, the values of the field appear in the prompt.

**Note**: Once an analytic document prompt is added to the canvas, the document is locked in an In-Document Analytics output format. You cannot change the HTML Analytic Document or PDF Analytic Document format if there are prompts present on the canvas. To switch to a non-active output format, you must remove all prompts.

### Using Multiple Reports as Targets and Sources

You can add multiple reports and charts to an In-Document Analytics enabled dashboard. Each report can have multiple prompts associated with it.

**Procedure**: **How to Build a Dashboard With Multiple Reports as Targets and Sources**

The following procedure describes how to set up analytic document prompts for two reports on a dashboard. In the example that is used, the first report contains information about the categories of electronics products sold in various regions. The Product\_Category field will be bound to a group of radio buttons. Each radio button will represent a particular product category of electronics. When you select a radio button for a product category, for example, Accessories, the report will be filtered by your selection.

The second report contains information about the gender and geographic location of electronics consumers. The Gender field will be bound to a drop-down list. The list will display the values, F (female) and M (male). When you select a gender from the drop-down list, the report will be filtered by your selection.

1. Open InfoAssist in Document mode using the wf_retail_lite Master File.

2. Create an In-Document Analytics enabled dashboard by adding two reports with the following components, respectively:

   **Report 1**:

   - Product,Category
   - Store, Business, Region
   - Discount
1. Gross Profit

**Report 2:**

- Gender
- Customer, Continent
- Product, Category

3. On the Insert tab, in the analytic document prompts group, add the following active dashboard prompts to the dashboard, positioning them relative to each respective report.

- **Radio Button:** This prompt will be used for Report 1.
- **Drop Down:** This prompt will be used for Report 2.

For more information on working with analytic document dashboard prompts, see *How to Add an In-Document Analytics Dashboard Prompt to a Dashboard* on page 100.

4. Right-click the radio button analytic document dashboard prompt for which you want to bind a field to and click **Properties**.

The analytic document properties dialog box opens.

The Prompts list displays the two prompts (for example, radiobutton_1 and combobox_2) that were added to the dashboard in Step 3.

5. From the Report drop-down menu, select the report that contains the field to which you want to bind an analytic document prompt.

In this example, the radio button list (radiobutton_1) has been selected as the prompt for the region report (Report 1), as shown in the following image.
The next step describes how to bind the Product,Category field from the region report to the radio button list to filter that report.

6. From the Field drop-down menu, select the field to which you want to bind the analytic document prompt.

In this example, the Product,Category field has been selected for the radio button list (radiobutton_1), as shown in the following image.

**Note:** You can optionally specify an ascending or descending sort order for the current scenario.

7. Click OK.

The prompt is now bound to the field on the dashboard.
In the following image, the radio button list is bound to the Product, Category field. It displays all product categories by which you can filter the report.

8. Right-click the Drop Down analytic document prompt for which you want to bind a field and click Properties.

The analytic document properties dialog box opens again.

Notice that combobox_2, the prompt selected on the dashboard, is selected in the Prompts list.
9. From the Report drop-down menu, select the report (Report2) that contains the field to which you want to bind an analytic document prompt.

The next step describes how to bind the Gender field from the gender report to the drop-down list to filter that report.

10. From the Field drop-down menu, select the field (Gender) to which you want to bind the analytic document prompt.

Once the Gender field has been selected, Report2 (gender report) appears in the Targets list and Report1 (region report) appears in the Candidate Reports list.

**Note:** To move a report from the Candidate Reports list box to the Targets list box, select it and click the *Add to List* arrow. To remove a report from the Targets list box, select it and click the *Remove from List* arrow. You can select multiple reports by holding down the Ctrl key and clicking each one.

11. Click OK.

The prompt is now bound to the Gender field on the dashboard. You can now filter the gender report by female or male, as shown in the following image.

![Filter Options](image-url)
The final dashboard displays, as shown in the following image.

![Dashboard Image]

**Procedure:**  **How to Change the Field**

You can change the field to which the analytic document prompt is bound.

1. Create an In-Document Analytics enabled dashboard in Document mode, or open an existing dashboard, and bind an analytic document prompt to a field.

2. Right-click the analytic document prompt that you want to configure, and click *Properties*. The analytic document prompt properties dialog box opens.

3. From the Field menu, select a different field.

   A warning message alerts you that changing the source field for the prompt will remove the existing prompt and any dependent (child) prompts from the cascades.

4. Click *OK* to close the warning.

5. Click *OK* to close the analytic document prompt properties dialog box. The analytic document prompt is updated with the new source field.
Procedure: How to Change the Filter Condition

1. Create an In-Document enabled dashboard in Document mode, or open an existing dashboard, and bind an analytic document prompt to a field, as described in How to Add an In-Document Analytics Dashboard Prompt to a Dashboard on page 100.

2. Right-click the analytic document prompt that you want to work with, and from the shortcut menu, select Properties.

   The analytic document prompt properties dialog box opens.

3. From the Condition drop-down menu, select the filter condition for the analytic document prompt. The options are Equal to, Not equal to, Less than, Less than or equal to, Greater than, and Greater than or equal to.

4. Click OK.

   The filter condition is applied to the analytic document prompt.

Procedure: How to Add Multiple Prompts to a Dashboard

1. Create an In-Document Analytics dashboard in Document mode, or open an existing dashboard containing at least one report, and add at least two analytic document prompts, as described in How to Add an In-Document Analytics Dashboard Prompt to a Dashboard on page 100.

2. Bind the fields to prompts that you have added, as described in How to Add an In-Document Analytics Dashboard Prompt to a Dashboard on page 100.

Procedure: How to Cascade Prompts

When you have more than one prompt on the canvas, you can cascade prompts to populate them based on the selections of the previous prompts. Cascading prompts have a parent-child relationship, in which the parent filters the available options of the child.

An analytic document prompt can be the parent of more than one other prompt, but cannot be a child of more than one prompt.

1. Create an In-Document analytics dashboard in Document mode, or open an existing dashboard, and bind at least two analytic document prompts to fields.

2. Right-click the analytic document prompt that you want to configure, and click Properties.

   The analytic document properties dialog box opens.

3. Click Cascades.
By default, a cascade named Cascade1 appears in the Cascades section of the analytic
document prompt properties dialog box.

- You can click the *Create a new cascade* button to create a new cascade.

- You can click the *Delete selected cascade* button to delete the selected cascade.

4. Select the cascade to which you want to add prompts.

5. From the Available Prompts list box, select the prompt that you want to add.

6. Click the *Add to List* arrow to move the selected prompt to the Selected Prompts list box.
   
   **Note:** You can remove prompts from the Selected Prompts list box by selecting them and clicking the *Remove from List* arrow.

7. Add any additional prompts you want to be part of the cascade by repeating steps 5 and 6.

   By default, the hierarchy of the prompts is determined by the order in which they are added to the Selected Prompts list. The cascade of the prompts is from top to bottom. The prompts that come first in the Selected Prompts list are the parents of the lower prompts.

8. You can change the hierarchy of the prompts by selecting a prompt in the Selected Prompt list box and clicking the Move Up and Move Down arrows.

9. Click *OK*.

   The cascade is created.

10. Run the report.

   **Note:** If you set up more than one cascade, the cascade that you interact with last is the one that filters the report.
This topic describes In-Document Analytics features and functions available on mobile and gesture-enabled devices with multi-touch capability, such as the Apple® iPhone® and Apple iPad®.

In this chapter:

- Requirements for Mobile Web Apps
- Mobile Web Apps Features
- Standard Gesture Support
- Running an In-Document Analytics Report on a Mobile Device
- Running an In-Document Analytics Dashboard on a Mobile Device

Requirements for Mobile Web Apps

Apple requires that any web content that is accessed from an iPhone app is compatible with, and optimized for display on, all Apple iOS-based devices. Active Technologies comply with web standards and are compatible with the Apple Safari browser.

For additional information, see Web Browser Support for WebFOCUS, which can be accessed by clicking on the following URL:

https://techsupport.informationbuilders.com/tech/wbf/wbf_tmo_027.html

Note: Some browsers may function differently depending on the operating system. See the WebFOCUS Release Notes for detailed information on known issues related to browser version or configuration.

Mobile and Tablet Device Support Information

The following apply to In-Document Analytics for mobile web apps.

- In-Document Analytics for Adobe Flash Player and for PDF are not supported on devices that do not support Adobe® Flash® Player. Only In-Document Analytics HTML JavaScript charts are available on such devices.

- Running an AHTML report with more than 30,000 records may cause the mobile Safari browser to close on the Apple iPad. To handle a large set of data when using Safari on iPad, turn on the active cache feature.
If you are viewing interactive content on a smartphone where the size of the screen of the device measures 400 pixels, your content will always display in Full screen mode even when you switch between portrait or landscape views, to maximize your view of the output.

Mobile Web Apps Features

The following features apply to In-Document Analytics implemented on mobile devices.

- In-Document Analytics checks for the screen size of the device at run time. If the height of the screen is less than 500 pixels, In-Document Analytics assume that the report or dashboard is running on a mobile device and the mobile user interface is used. This feature applies when the device is in either portrait or landscape mode.

- By default, In-Document Analytics use tab window navigation, familiar to most users. In tab window navigation, open windows are represented by tabs across the top of a report. Tap a tab to navigate between windows.

**Important:**

- In full-screen web app view, Rollup and Pivot tables created from Rollup menu options are not displayed. You can view them when you switch to the original interactive report view.

- In full-screen web app view, the totals in a Pivot table may appear misaligned when switching BY and ACROSS columns in the Pivot table.

Standard Gesture Support

In-Document Analytics support the following standard interactive gestures that are used on a multi-touch screen.

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap</td>
<td>To press or select a control or item (analogous to a single mouse click).</td>
</tr>
<tr>
<td>Drag</td>
<td>To move columns left and right or up and down slowly when an active report is in a grid in full-screen web app view.</td>
</tr>
<tr>
<td>Flick</td>
<td>To move columns left and right or up and down quickly when an active report is in a grid in full-screen web app view.</td>
</tr>
</tbody>
</table>
The following table lists and describes gestures specific to mobile charts.

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Swipe</td>
<td>To page forward or backward in a pagination bar when an active report is in a grid in full-screen web app view.</td>
</tr>
<tr>
<td>Double tap</td>
<td>To zoom in and center a block of content or an image. If you are already zoomed in, a double tap zooms out.</td>
</tr>
<tr>
<td></td>
<td>You can also double tap the screen to hide both the top and bottom toolbars, as well as the pagination bar. Double tap the screen again to show both toolbars and the pagination bar.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap</td>
<td>The tap gesture is used to select or highlight an item, such as a riser, and show its tooltip (analogous to pausing the mouse over an object).</td>
</tr>
<tr>
<td>Long touch</td>
<td>Touching and holding an item, such as a riser, is used to trigger a drop-down menu on events that support it (analogous to a single mouse click).</td>
</tr>
<tr>
<td>Short drag</td>
<td>Can be used interchangeably with long drag for either scrolling (on charts with scroll bars or moving around on maps) or for marquee data selection.</td>
</tr>
<tr>
<td></td>
<td>On charts that include both scrolling and marquee selections, a short drag will scroll and a long drag will do a marquee data selection.</td>
</tr>
<tr>
<td>Long drag</td>
<td>Can be used interchangeably with short drag for either scrolling (on charts with scroll bars or moving around on maps) or for marquee data selections.</td>
</tr>
<tr>
<td></td>
<td>Note that if a chart supports only scrolling or only marquee selections, then a long drag does nothing.</td>
</tr>
<tr>
<td></td>
<td>On charts that include both scrolling and marquee selections, a short drag will scroll and a long drag will do a marquee data selection.</td>
</tr>
</tbody>
</table>
The following image shows a tooltip that appears when you tap on a riser in the Legacy version of In-Document Analytics (for example, the pie slice with the largest data value).

![Tooltip Image](image1)

The following image shows the options available for a marquee data selection in the Legacy version of In-Document Analytics, also known as lassoing (for example, when a long drag is performed over the two pie slices with the largest data values).

![Marquee Selection Image](image2)
Running an In-Document Analytics Report on a Mobile Device

The following image shows a sample interactive report that is running on an iPad in full-screen web app view using the Legacy style.
The following image shows a sample interactive report that is running on an iPad in full-screen web app view using the Designer style.

You can use the icons on the pagination bar of the grid in an interactive report to:

- Adjust the viewing mode, which can be either full-screen web app view or original interactive report view.

- Position the pagination bar at the top or bottom of the report.

By tapping the column title of a report, you can access the report column drop-down menu to refine the data in different ways and manipulate the way that you present it.

You can also use the icons on the chart, rollup, or pivot tool bar of an interactive report to adjust the viewing mode, which can be either full-screen web app view or original active report view.
Adjusting the Views

In the Legacy style, tap the Fullscreen View icon to display the report in full-screen web app view mode. In Designer mode, tap the Fullscreen View icon to display the report in full-screen web app view mode. Full-screen web app view means that the report is presented as a gesture-enabled web app with the features and functionalities customized for mobile and touch-screen devices. This is the default view for the display of a report on mobile and multi-touch devices.

In full-screen web app view, tap the Original View icon to restore the report to its original interactive report view. Original interactive report view means that the report is presented as a regular active report running inside the browser. All the functionalities of interactive reports in the desktop browser are intact in this mode, except the window display option, which is set to Tabs instead of Cascade by default to accommodate devices with small screen sizes.

In the Designer style, you can exit fullscreen or restore original using the options shown on the hamburger menu, as shown in the following image.

![Hamburger menu with options](image)

Adding an In-Document Analytics Report or Dashboard to the Home Screen

For easy access, you can add an interactive report or dashboard to the Home screen of your device. When an interactive report or dashboard is added to the Home screen, it will create an icon of the report or dashboard. The user can tap the icon to access the interactive report or dashboard instead of entering its URL in the device browser. When the interactive report or the dashboard is opened from the Home screen, it will connect to WebFOCUS to retrieve the most up-to-date information. Accessing interactive reports and dashboards from the icon provides more space to view reports or dashboards on devices with small screen sizes. There will be no browser toolbars to take up screen space.

To add an interactive report or dashboard to the Home screen on the iPhone and iPad, open an interactive report or dashboard in the browser and then tap the Action icon at the bottom of the screen. Tap the Add to Home Screen option.
To add an interactive report or dashboard to the Home screen on Android devices, open an interactive report or dashboard in the browser and open the menu options. Tap *Add shortcut to Home*. Depending on your device, you may need to tap *Add bookmark* first. In this case, go to the Bookmarks list and touch and hold the bookmark you just added to bring up the *Add shortcut to Home* option.

**Hiding and Showing the Pagination Bar and the Top and Bottom Toolbars**

In full-screen web app view, you can hide the pagination bar and the top and bottom toolbars of the grid and chart. This is done so that there is more space to view the interactive reports and charts on devices with small screen sizes.

To do this:

1. Click the *Fullscreen View* icon to display the report in full-screen web app view, if it is not already in that view.

2. In the grid cell data area or in a chart, double tap to hide the pagination bar and the top and bottom toolbars.

3. In the grid cell data area or in a chart, double tap to show the pagination bar and the top and bottom toolbars.

**Navigating Between Pages**

To navigate between the pages of an interactive report:

1. Click the *Fullscreen View* icon to display the report in full-screen web app view if it is not already in that view.

2. On the pagination bar, swipe from right to left to display the next page of the report.

3. On the pagination bar, swipe from left to right to display the previous page of the report.
Accessing the Report Column Drop-Down Menu

The following image shows a sample report column drop-down menu for a numeric data column in full-screen web app view in the Legacy style.

The menu option Visualize is available only for numeric data. The menu options Show Columns and Show All are available only when there are hidden columns in the report. The menu options Freeze Column and Unfreeze All are available only in full-screen web app view.
The following image shows the Column menu, which is available in the Designer style. It offers comparable functionality to that which is offered in the Legacy style.

Procedure: How to Access the Report Column Drop-Down Menu in the Legacy Style

1. On a run-time tabular report (grid), tap once on a column title.
   The report column drop-down menu is displayed, with a selection of options.

2. Tap the desired menu option. An arrow to the right of a menu option means that there is an additional menu associated with that option. The options and their associated menus are described in the topics that follow.

3. To remove the report column drop-down menu, tap Cancel.

Procedure: How to Access the Report Column Drop-Down Menu in the Designer Style

1. On a run-time tabular report (grid), tap once on a column title.
   The Column menu is displayed, with a selection of options.

2. Tap the desired option (for example, Chart, Rollup or Pivot).

3. Optionally, add filters or highlight rows in your report.
4. To remove the options that you have specified through the Column menu, tap the filter icon at the top of the column.

Sorting Data

You can sort data in any column of an interactive report in ascending or descending order.

From the report column drop-down menu in the Legacy version, tap Sort Ascending to sort the data in ascending order. In Designer style, click Ascending in the sort options section of the Column menu.

From the report column drop-down menu in the Legacy version, tap Sort Descending to sort the data in descending order. In Designer style, click Descending in the sort options section of the Column menu.

Filtering Data

On a run-time interactive report, locate and tap the title of the column that you wish to filter. From the report column drop-down menu in the Legacy version, tap Filter or touch the right arrow for the Filter menu option. The Filter menu is displayed, specifying the default filter condition and default values for the selected column in the existing report. In the Designer style, locate and tap the title of the column that you wish to filter. From the Column menu, tap Filter to specify filtering criteria.

The following image shows a sample Filter menu in the Legacy version. In this example, the default condition is Equals and the default value is Alabama. Alabama is the first value in the existing report for the selected column.

The menu retains any previous filters that were applied to this column of the report.
In the Legacy version, you can:

- Tap **Done** once to see the result of the default condition and values. The filtered report is automatically generated, and a new Filter tab is appended after the Report tab and any other existing tabs. On the new Filter tab, you can change the default condition and values to customize the filter for your reporting needs.

- You can also tap the Condition and Values drop-down dialog box to change the filter condition or values before tapping the Done button.

- Tap **Clear All** to remove all the filters that are currently applied to this report.

The Designer Style filter applies the changes dynamically as selections are made, as shown in the following image.
Using the Filter Tab

The following image shows a sample Filter tab for an interactive report (grid) in the Legacy style.

![Filter Tab Example]

The Filter tab shows all the filters that are applied to the report.

An individual filter applies only to the specific report from which the filter was created or to which the filter was added. You can scroll up and down the list to view all the individual filters.

From the Filter tab, you can do the following.

- Tap a drop-down list to change the filter condition or values. An asterisk next to a value (for example, next to Alabama in the preceding example) means that multiple values define the condition.
- Tap the Delete icon to remove an individual filter from the report.
- Tap Operator: AND to change the condition (operator) between all existing filters from AND (the default) to OR.
- Tap Add Condition to define a new filter.
- Tap Filter to apply a modified or new filter and generate the new report.
- Tap Highlight to apply highlight to the filtered values in the report.
- Tap Clear All to remove all the filters that are currently applied to the report.

Calculating Data

From the report column drop-down menu in the Legacy version, tap Calculate or touch the right arrow for the Calculate menu option to display a menu from which you can apply a calculation to the selected column.
The following image shows the Calculate menu for a numeric data column. The calculations that are available on the menu depend on the data type of the selected column: numeric, alphanumeric, or date.

<table>
<thead>
<tr>
<th>Back</th>
<th>Calculate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
<td></td>
</tr>
<tr>
<td>Clear All</td>
<td></td>
</tr>
<tr>
<td>Sum</td>
<td></td>
</tr>
<tr>
<td>Avg</td>
<td></td>
</tr>
<tr>
<td>Min</td>
<td></td>
</tr>
<tr>
<td>Max</td>
<td></td>
</tr>
<tr>
<td>Count</td>
<td></td>
</tr>
<tr>
<td>Distinct</td>
<td></td>
</tr>
<tr>
<td>% of Total</td>
<td></td>
</tr>
</tbody>
</table>

Note that the options for the Designer style are similar.

In the Legacy version, you can do the following:

- Tap a calculation type in the list. A new report is generated on the Report tab. The calculated result for the selected column is displayed at the location in the grid specified in the WebFOCUS report procedure. Depending on the size of the screen that you are using, the calculated result may be displayed over two lines.

- From the report column drop-down menu, tap Calculate and then tap Clear to remove the calculation that was last applied to the report.

- From the report column drop-down menu, tap Calculate and then tap Clear All to remove all the calculations that are currently applied to the report.
Viewing Data as a Chart

When you run an interactive report on an iPad, you can tap Chart from the report column drop-down menu and tap the right arrow, or touch the right arrow for the Chart menu option to display a menu that specifies the default value for the type of chart that will be displayed and the default aggregation (calculation) that will be used to draw the chart. Also listed are the columns that are available for display on the X-axis of the chart (the Group By columns).

The following image shows a sample Chart menu. In this example, the default chart type is Bar and the default aggregation is Sum, for the selected numeric data column. Columns that can be displayed on the X-axis (Group By columns) are listed on the menu.

You can access the same menu from the Advanced Chart icon at the bottom of the screen if you are already in a chart in full-screen web app view. This menu and icon apply to the WebFOCUS HTML5 chart engine (ARGRAFENGINE=JSCHART).
Similar options are available in the Designer style, which display when you tap a column heading, as shown in the following image.

Tap a Group By column for the X-axis to automatically generate a chart that is the result of the default values and the selected X-axis column. The chart is displayed in tab view, with a new Chart tab appended after the Report tab and any other existing tabs.

The chart is generated in full-screen web app view by default, if you are in that view.

Alternatively, you can tap the Chart Type menu to change the chart type or tap the Aggregation drop-down menu to change the calculation type, before selecting the Group By column to generate the new chart.
Tapping the Chart Type menu displays the Chart Type options, as shown in the following image.

<table>
<thead>
<tr>
<th>Back</th>
<th>Chart Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar</td>
<td>&gt;</td>
</tr>
<tr>
<td>Column</td>
<td>&gt;</td>
</tr>
<tr>
<td>Pie</td>
<td>&gt;</td>
</tr>
<tr>
<td>Line</td>
<td>&gt;</td>
</tr>
<tr>
<td>Area</td>
<td>&gt;</td>
</tr>
<tr>
<td>Scatter</td>
<td>&gt;</td>
</tr>
<tr>
<td>Other</td>
<td>&gt;</td>
</tr>
</tbody>
</table>
In the Designer style, you can select a chart type from the column menu, as shown in the following image.
In the Legacy format, once you have selected a chart type category, such as Pie, and then tap the Donut chart type that will be used to display the chart. The following image shows some of the charts in the Pie category.

If you are using the WebFOCUS Mobile Faves for iOS app, it may take a moment for the chart types in a chart category to be displayed. There is no JavaScript engine that renders JavaScript faster inside the iOS app, and JavaScript cannot take advantage of features such as hardware acceleration.

On the new Chart tab, you can change the values to customize the chart for your reporting needs. You can also manipulate the way that you present the data.
Using the In-Document Analytics Chart Menu

In the Legacy version, the interactive chart menu and its submenus allow you to change the columns used in the chart or rollup table or select multiple columns from those available in the report, including hidden and NOPRINT columns.

The following image shows the interactive chart menu.

<table>
<thead>
<tr>
<th>Cancel</th>
<th>menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td></td>
</tr>
<tr>
<td>Original View</td>
<td></td>
</tr>
<tr>
<td>Group By (X)</td>
<td>&gt;</td>
</tr>
<tr>
<td>Add (Y)</td>
<td>&gt;</td>
</tr>
<tr>
<td>Restore Original</td>
<td></td>
</tr>
</tbody>
</table>
Similar options are available for the Designer style, including Rollups and Pivoting that support Group By and Across fields, as shown in the following image.

In the Legacy version, you can:

- Tap **New** to create a copy of the same chart on a new Chart tab.
- Tap **Original View** or **Fullscreen** to display the chart in the desired viewing mode.
- Tap **Group By (X)** to change the column selected for the X-axis (the Group By field) or add any column available in the report, including hidden and NOPRINT columns. On the Group By (X) submenu, values used in the existing chart are displayed at the top of the column names and are selected (checked) by default. A newly selected X-axis column is displayed at the top of the column names and is checked.
For a bar chart, tap Stacked to create a stacked AHTML bar chart.

The following image shows a sample Group By (X) submenu. The column Product Type is used as the X-axis in the existing chart.

Tap once to select an additional column, or tap again to deselect the column. Once you select or deselect a column, the Chart tab displays the modified chart, reflecting all the changes.

- Tap Add (Y) to change the column selected for the Y-axis or add any column available in the report, including hidden and NOPRINT columns. On the Add (Y) submenu, the values used in the existing chart are selected by default.
The following image shows a sample Add (Y) submenu. The column Cost of Goods is used as the Y-axis in the existing chart.

<table>
<thead>
<tr>
<th>Back</th>
<th>Add (Y)</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td></td>
</tr>
<tr>
<td>Region</td>
<td></td>
</tr>
<tr>
<td>Product Type</td>
<td></td>
</tr>
<tr>
<td>Product Name</td>
<td></td>
</tr>
<tr>
<td>Revenue</td>
<td></td>
</tr>
<tr>
<td>Cost of Goods ✓</td>
<td></td>
</tr>
</tbody>
</table>

Tap once to select an additional column, or tap again to deselect the column. Once you select or deselect a column, the Chart tab displays the modified chart, reflecting all the changes.

**Viewing Data in a Rollup Table**

Tap *Rollup* or touch the right arrow for the Rollup menu option to display a menu that specifies the default aggregation (calculation) that will be used to generate the rollup table. Also listed are the Group By columns that are available for display in the rollup table.
The following image shows a sample Rollup menu. In this example, the default aggregation is Sum for a numeric data column. The available Group By columns are listed on the menu.
Similar options are available for the Rollup menu in the Designer style, as shown in the following image.

![Rollup menu in Designer style](image)

Tap a Group By column to automatically generate a rollup table that is the result of the default aggregation value and the selected column. For the Designer type, click Create to create the rollup. You must select at least one Group By column. After you select a column, the rollup table is displayed in tab view, with a new Rollup tab appended after the Report tab and any other existing tabs.

The rollup table is generated in full-screen web app view by default, if you are in that view.

You can also tap the Aggregation drop-down menu to change the calculation type before selecting the Group By field to generate the new rollup.

On the new Rollup tab, you can change the values to customize the rollup table for your reporting needs, making it more complex as required for analysis. You can also manipulate the way that you present the data.
Using the Rollup Tab

The following image shows a sample Rollup tab.

<table>
<thead>
<tr>
<th>State</th>
<th>Cost of Goods</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alabama</td>
<td>$917,653.00</td>
</tr>
<tr>
<td>Alaska</td>
<td>$4,100,032.00</td>
</tr>
<tr>
<td>Arizona</td>
<td>$1,945,029.00</td>
</tr>
<tr>
<td>Arkansas</td>
<td>$925,570.00</td>
</tr>
<tr>
<td>Attaki</td>
<td>$270,603.00</td>
</tr>
<tr>
<td>Bangkok</td>
<td>$31,025.00</td>
</tr>
<tr>
<td>Beijing</td>
<td>$25,465.00</td>
</tr>
<tr>
<td>Berlin</td>
<td>$18,240,875.00</td>
</tr>
<tr>
<td>British Columbia</td>
<td>$18,268,612.00</td>
</tr>
<tr>
<td>Brussels Capital Region</td>
<td>$14,564,473.00</td>
</tr>
<tr>
<td>Budapest</td>
<td>$9,353,560.00</td>
</tr>
<tr>
<td>Cairo</td>
<td>$44,827.00</td>
</tr>
<tr>
<td>California</td>
<td>$10,975,134.00</td>
</tr>
<tr>
<td>Cataluna</td>
<td>$721,763.00</td>
</tr>
<tr>
<td>Central Singapore</td>
<td>$11,650,802.00</td>
</tr>
<tr>
<td>Colorado</td>
<td>$3,966,967.00</td>
</tr>
<tr>
<td>Distrito Federal</td>
<td>$19,615,007.00</td>
</tr>
<tr>
<td>Distrito Federal</td>
<td>$9,296,624.00</td>
</tr>
<tr>
<td>England</td>
<td>$22,779,443.00</td>
</tr>
<tr>
<td>Florida</td>
<td>$5,207,100.00</td>
</tr>
<tr>
<td>Geneva</td>
<td>$18,523,247.00</td>
</tr>
<tr>
<td>Georgia</td>
<td>$9,935,509.00</td>
</tr>
<tr>
<td>Hawaii</td>
<td>$735,434.00</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>$25,237.00</td>
</tr>
<tr>
<td>Hovechbaden</td>
<td>$18,309,087.00</td>
</tr>
<tr>
<td>Idaho</td>
<td>$225,572,993.00</td>
</tr>
<tr>
<td>Ile-de-France</td>
<td>$9,002,434.00</td>
</tr>
<tr>
<td>Illinois</td>
<td>$13,857,876.00</td>
</tr>
<tr>
<td>Indiana</td>
<td>$4,079,875.00</td>
</tr>
<tr>
<td>Iowa</td>
<td>$925,958.00</td>
</tr>
<tr>
<td>Istanbul</td>
<td>$283,776.00</td>
</tr>
<tr>
<td>Kansas</td>
<td>$3,070,817.00</td>
</tr>
<tr>
<td>Kamatsika</td>
<td>$616,889.00</td>
</tr>
<tr>
<td>Kentucky</td>
<td>$941,247.00</td>
</tr>
<tr>
<td>Lazio</td>
<td>$18,528,382.00</td>
</tr>
<tr>
<td>Leinsler</td>
<td>$13,408,048.00</td>
</tr>
<tr>
<td>Lisbon</td>
<td>$293,954.00</td>
</tr>
<tr>
<td>Lombardia</td>
<td>$18,649,731.00</td>
</tr>
<tr>
<td>Louisiana</td>
<td>$3,220,823.00</td>
</tr>
</tbody>
</table>
In the Designer style, when you create a Rollup, a separate artifact is placed in the Analysis panel, as shown in the following image.

In the Legacy style, beneath the rollup table is the chart or rollup tool bar, which contains the icons described in the following table.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="More Options" /></td>
<td>More Options</td>
<td>Displays the interactive chart or rollup menu. For details, see <em>Using the Rollup Menu</em> on page 137.</td>
</tr>
<tr>
<td><img src="image" alt="Column" /></td>
<td>Column</td>
<td>Changes the report to a column chart.</td>
</tr>
<tr>
<td><img src="image" alt="Pie" /></td>
<td>Pie</td>
<td>Changes the report to a pie chart.</td>
</tr>
<tr>
<td><img src="image" alt="Line" /></td>
<td>Line</td>
<td>Changes the report to a line chart.</td>
</tr>
<tr>
<td>Icon</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Scatter</td>
<td>Changes the chart type to scatter. Scatter charts are available for numeric columns.</td>
</tr>
<tr>
<td></td>
<td>Rollup</td>
<td>Displays the chart as a rollup table.</td>
</tr>
<tr>
<td></td>
<td>Advanced Chart</td>
<td>Opens the chart tool to change the chart type.</td>
</tr>
<tr>
<td></td>
<td>Original Chart</td>
<td>Restores the current chart type to the initial chart type that was displayed.</td>
</tr>
<tr>
<td></td>
<td>Lock/Unlock</td>
<td>Freezes the chart or rollup table. You can link or unlink a chart or rollup table to the filters that you have applied in your report using the Freeze Chart or Freeze Rollup icon. The icon indicates whether the report is linked to the filter (Freeze Chart or Freeze Rollup) or not (Unfreeze Chart or Unfreeze Rollup).</td>
</tr>
<tr>
<td></td>
<td>Aggregation</td>
<td>Changes the aggregation method.</td>
</tr>
</tbody>
</table>
Using the Rollup Menu

The rollup menu and its submenus allow you to select multiple columns from those available in the report, including hidden and NOPRINT columns.

The following image shows the rollup menu.
In the Designer style, the Rollup menu displays as part of the Column menu, as shown in the following image.

To access the Rollup menu in the Legacy style, tap the More Options icon with a rollup table open.

In the Legacy version, you can:

- Tap New to create a copy of the same rollup table on a new Rollup tab.
- Tap Original View or Fullscreen to display the rollup table in the desired viewing mode.
- Tap Group By (X) to change the column selected for the X-axis (the Group By field) or add any column available in the report, including hidden and NOPRINT columns. On the Group By (X) submenu, the Group By column used in the existing rollup table is displayed at the top of the column names and is selected (checked) by default.
The following image shows a sample Group By (X) submenu. The column Product Type is the Group By column for the existing rollup table.
In the Designer style, the Group by Values display when you click on the Group By field, as shown in the following image.

In the Legacy style, tap once to select an additional column, or tap again to deselect the column. In the Designer style, click Create to create the Rollup. Once you select or deselect a column, the Rollup tab displays the modified rollup table, reflecting all the changes.

- Tap Add (Y) to change the column selected for the Y-axis or add any column available in the report, including hidden and NOPRINT columns. On the Add (Y) submenu, the Y-axis column used in the existing report is selected by default.
The following image shows a sample Add (Y) submenu. The column Cost of Goods is the Y-axis column for the existing report.

<table>
<thead>
<tr>
<th>Back</th>
<th>Add (Y)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td></td>
</tr>
<tr>
<td>Product Type</td>
<td></td>
</tr>
<tr>
<td>Product Name</td>
<td></td>
</tr>
<tr>
<td>Revenue</td>
<td></td>
</tr>
<tr>
<td>Cost of Goods ✓</td>
<td></td>
</tr>
</tbody>
</table>
In the Designer Style, you can similarly add a Y-axis column for the current report.

In the Legacy Style, tap once to select an additional column, or tap again to deselect the column. In the Designer style, click Create to create the Rollup. Once you select or deselect a column, the Rollup tab displays the modified rollup table, reflecting all the changes.

**Viewing Data in a Pivot Table**

Tap Pivot (Cross Tab) or touch the right arrow for the Pivot (Cross Tab) menu option to display a menu that specifies default values for the aggregation (calculation) that will be used to generate the pivot table, the column that will be displayed across the pivot table, and the Group By column that will be used to generate the table.
The following image shows a sample Pivot Tool menu in the Legacy style. In this example, the aggregation is Sum (default for a numeric column), the Across column is Product Type, and the Group By column is Region. A pivot table requires at least one across column and one Group By column. The first value for the column in the report is displayed by default.
In the Designer style, the aggregation is also Sum, the Group By column is Product Category, and the Across column is Product Subcategory, as shown in the following image.

In the Legacy style, tap Done once to see the result of the default values. In the Designer style, click Create to create the pivot table. The pivot table is automatically generated in tab view, and a new Pivot tab is appended after the Report tab and any other existing tabs.

The pivot table is generated in full-screen web app view by default, if you are already in that view.

On the new Pivot tab, you can change the default values to customize the pivot table for your reporting needs, making it more complex as required for analysis.
Using the Pivot Tab

The following image shows a sample Pivot table in Legacy style.

<table>
<thead>
<tr>
<th>Region</th>
<th>Accessories</th>
<th>Computers</th>
<th>Media Player</th>
<th>Stereo Systems</th>
<th>Televisions</th>
<th>Video Production</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMEA</td>
<td>$35,892,933.00</td>
<td>$24,333,419.00</td>
<td>$77,067,725.00</td>
<td>$82,327,915.00</td>
<td>$25,348,963.00</td>
<td>$16,014,723.00</td>
<td>$303,046,783.00</td>
</tr>
<tr>
<td>North America</td>
<td>$51,446,810.00</td>
<td>$24,333,419.00</td>
<td>$77,067,725.00</td>
<td>$82,327,915.00</td>
<td>$25,348,963.00</td>
<td>$16,014,723.00</td>
<td>$303,046,783.00</td>
</tr>
<tr>
<td>Oceania</td>
<td>$105,032.00</td>
<td>$117,446.00</td>
<td>$234,889.00</td>
<td>$61,989.00</td>
<td>$41,764.00</td>
<td>$898,749.00</td>
<td></td>
</tr>
<tr>
<td>South America</td>
<td>$2,309,123.00</td>
<td>$2,787,191.00</td>
<td>$1,498,680.00</td>
<td>$5,000,092.00</td>
<td>$5,245,426.00</td>
<td>$1,660,641.00</td>
<td>$1,041,209.00</td>
</tr>
</tbody>
</table>

The following image shows a sample Pivot table in Designer style.

Beneath the pivot table in Legacy style is the active pivot tool bar, which contains the icons described in the following table.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Displays the active pivot menu. For details, see <em>Using the Pivot Menu</em> on page 146.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Freezes the pivot table. You can link or unlink a pivot table to the filters that you have applied in your report using the Freeze Pivot icon. The icon indicates whether the report is linked to the filter (Freeze Pivot) or not (Unfreeze Pivot).</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Changes the aggregation method.</td>
</tr>
</tbody>
</table>

**Using the Pivot Menu**

In the Legacy style, the pivot menu and its submenus allow you to select multiple columns from those available in the report, including hidden and NOPRINT columns.

The following image shows the pivot menu.

![Pivot Menu](image4)
In the Designer style, the options are similar, as shown in the following image.

In the Legacy version, you can:

- Tap New to create a copy of the same pivot table on a new Pivot tab.
- Tap Group By (X) to change the column selected for the X-axis (the Group By field) or add any column available in the report, including hidden and NOPRINT columns. On the Group By (X) submenu, the Group By and Across columns used in the existing pivot table are displayed at the top of the column names and are selected (checked) by default. You can switch Group By and Across columns using the arrow icons in the pivot table at run time.
The following image shows a sample Group By (X) submenu. The Product Type column is used for the Across column and the Region column is used for the Group By column in the existing pivot table.

<table>
<thead>
<tr>
<th>Back</th>
<th>Group By (X)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Product Type</td>
</tr>
<tr>
<td></td>
<td>Region</td>
</tr>
<tr>
<td></td>
<td>State</td>
</tr>
<tr>
<td></td>
<td>Product Name</td>
</tr>
<tr>
<td></td>
<td>Revenue</td>
</tr>
<tr>
<td></td>
<td>Cost of Goods</td>
</tr>
</tbody>
</table>

Tap once to select an additional column, or tap again to deselect the column. Once you select or deselect a column, the Pivot tab displays the modified pivot table, reflecting all the changes.

- Tap Add (Y) to change the column selected for the measure field to any column available in the report, including hidden and NOPRINT columns. On the Add (Y) submenu, the measure column used in the existing report is selected by default.
The following image shows a sample Add (Y) submenu. The column Cost of Goods is the measure field for the existing report.

<table>
<thead>
<tr>
<th>Back</th>
<th>Add (Y)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td></td>
</tr>
<tr>
<td>Product Type</td>
<td></td>
</tr>
<tr>
<td>Product Name</td>
<td></td>
</tr>
<tr>
<td>Revenue</td>
<td></td>
</tr>
<tr>
<td>Cost of Goods</td>
<td></td>
</tr>
</tbody>
</table>

Tap once to select a column, or tap again to deselect the column. Once you select or deselect a column, the Pivot tab displays the modified pivot table, reflecting all the changes.

**Using Data Visualization**

Tap Visualize to add or remove visualization bars to the selected column. The Visualize option is available for numeric data columns.

**Hiding or Restoring a Column**

Tap Hide Column to suppress the display of the selected column in the report.

Tap Show All to restore all the hidden columns to the report.

Tap Show Columns to list the names of the columns that are hidden in the report, allowing you to individually restore a column.

Tap the name of a specific column in the hidden columns list to restore that column to the report.

The Show All and Show Columns options are available only when there are hidden columns in the report.
Freezing or Unfreezing a Column

Tap **Freeze Column** to freeze the selected column and all the columns to the left of it. You cannot scroll left or right within the frozen part of the report, but you can scroll up and down within the frozen part. You can scroll in any direction in the unfrozen part of the report.

Tap **Unfreeze All** to unfreeze all the frozen columns in the report.

**Note:** This functionality is currently not supported in the Designer style of In-Document Analytics.

In full-screen Web app view, the column titles and report headings will stay fixed as you scroll through the report when the Freeze Column option is turned on.

Controlling the Number of Records Per Page

In the Legacy style, tap **Show Records** or touch the right arrow for the Show Records menu option to list the groups of records available for display per page in the report. On the Show Records menu, you can:

- Tap a group of records (for example, **20 Records**) to display, per page, only the number of records in that group.

- Tap **Default** to display the number of records (lines) per page that is specified in the WebFOCUS report procedure.
Tap Show All to display all the records in a single page.

<table>
<thead>
<tr>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 Records</td>
</tr>
<tr>
<td>10 Records</td>
</tr>
<tr>
<td>15 Records</td>
</tr>
<tr>
<td>20 Records</td>
</tr>
<tr>
<td>25 Records</td>
</tr>
<tr>
<td>30 Records</td>
</tr>
<tr>
<td>35 Records</td>
</tr>
<tr>
<td>40 Records</td>
</tr>
<tr>
<td>50 Records</td>
</tr>
<tr>
<td>60 Records</td>
</tr>
<tr>
<td>Show All</td>
</tr>
</tbody>
</table>

In the Designer style, you can use the navigational arrows along the bottom of the interface to navigate groups of data.

**Restoring a Report to Its Original State**

In the Legacy version, tap Restore Original to restore the interactive report to its default state specified in the WebFOCUS report procedure. In the Designer version, tap the hamburger menu and tap Restore Dashboard.

**Unsupported Menu Options**

The following menu options are not supported by In-Document Analytics for mobile web apps.

- Comments
- Send as E-mail
Running an In-Document Analytics Report on a Mobile Device

- Save Changes
- Grid Tool
- Chart/Rollup Tool
- Pivot Tool
- Export and Export to for a chart
- Print
- Window
- Accordion

**Note:** Active cell menu options are not supported (for example, Comments, Highlight Value, Highlight Row, Unhighlight All, and Filter Cell).
Running an In-Document Analytics Dashboard on a Mobile Device

**Note:** Adaptive Dashboard is only available in the Legacy version of In-Document Analytics.
The following image shows a sample interactive dashboard that is running on an iPad, with Adaptive Dashboard disabled (this is the default).

The dashboard bar at the top of an interactive dashboard contains the page layout tabs. On mobile devices, the bar is floating instead of fixed, making the available functions always accessible, no matter where you move within the dashboard.

You can use standard gestures on an interactive dashboard to scroll left and right or up and down, or zoom in and zoom out.

You can tap the Fullscreen View icon on the right edge of the pagination bar for an individual grid or on the right edge of a chart tool bar or pivot tool bar to view the grid, chart, rollup table, or pivot table on the dashboard in full-screen mode.
This topic describes how to implement design features that enhance your applications using WebFOCUS syntax.

The reports, charts, and dashboards described in this topic are enabled to use the full capabilities of In-Document Analytics. They are called In-Document Analytics reports or interactive reports, In-Document Analytics charts or interactive charts, and In-Document Analytics dashboards or interactive dashboards.

For more information about how to create, style, and analyze reports and charts with the WebFOCUS language, see the Creating Reports With WebFOCUS Language manual.

In this chapter:

- Controlling the In-Document Analytics Cache
- Suppressing the Display of the Filter Options in a Tooltip
- Styling the Filter Selection Dialog Box
- Implementing Cascading Multi Drill
- Customizing the Page Range on the Pagination Bar

Controlling the In-Document Analytics Cache

Because all post-retrieval processing is performed in the memory of the web browser, an interactive report has a processing limit of approximately 5,000 records or 100 pages of output. The cache option enables you to send only the first page of report output to the browser and retrieve subsequent pages from a temporary cache on the WebFOCUS Reporting Server. The server also becomes the resource for performing all calculations, sorting, and filtering when cache is enabled. Since cache uses on-demand paging functionality, WebFOCUS Viewer is not supported.

You can enable cache and set its mode and format, using the SET commands described in this topic. For details on the ways that you can issue a SET command, see the Developing Reporting Applications manual.
Syntax: How to Enable the In-Document Analytics Cache for Active Technologies Reports

The syntax is

```
SET WEBVIEWER = {ON|OFF}
SET CACHELINES = {n|100}
```

where:

**ON**
- Runs the report with cache enabled.

**OFF**
- Does not enable cache when the report is run. OFF is the default value.

```
n|100
```
- Specifies the number of rows retrieved from cache. The default value is 100.

**Tip:** It is recommended that you set the number of rows retrieved five times greater than the number of lines retrieved per page (as indicated in SET LINES). The minimum number of rows retrieved is 100. Setting LINES greater than 200 with the AHTML output format produces a report with no output. If editing the SET LINES syntax for a procedure with AHTML, it is recommended that you code SET LINES equal to or less than 200 since the Internet Explorer JavaScript engine is slower than any other browser (such as Firefox, Opera, Google Chrome, and so on).

You can also issue the SET WEBVIEWER and SET CACHELINES commands within a request using:

```
ON TABLE SET WEBVIEWER {ON|OFF}
ON TABLE SET CACHELINES {n|100}
```

Syntax: How to Set the Mode of the In-Document Analytics Cache

The SET ARCACHEMODE command determines which HOLD files are created on the WebFOCUS Reporting Server for use with cache. For details on HOLD files, see the *Creating Reports With WebFOCUS Language* manual.

The syntax is

```
SET ARCACHEMODE = {HOLD|NOHOLD|NOEXTRACT}
```
where:

**HOLD**
When combined with ARCACHEFMT=BINARY, this setting results in the original behavior of cache. HOLD files for all requests are created on the WebFOCUS Reporting Server. This is the default value.

**NOHOLD**
Suppresses the creation of HOLD files for Rollup tables and charts.

**NOEXTRACT**
Suppresses the creation of all HOLD files, including the initial extract. Use this setting when the target database table is pre-built and does not change often.

You can also issue the SET ARCACHEMODE command within a request using:

```
ON TABLE SET ARCACHEMODE {HOLD|NOHOLD|NOEXTRACT}
```

**Syntax:**

**How to Set the Format of the In-Document Analytics Cache**

The SET ARCACHEFMT command determines the format in which data is stored in a HOLD file. The syntax is

```
SET ARCACHEFMT = any_valid_database_format
```

where:

**any_valid_database_format**
Is an output file format supported by WebFOCUS, for example, BINARY or FOCUS.

- **BINARY** format saves report data and stores numeric fields as binary numbers. When created as a HOLD file, BINARY also generates a Master File. BINARY is the default value for HOLD files.

- **FOCUS** format creates a proprietary FOCUS data source. Four files result: a HOLD data file, a HOLD Master File, and two work files.

For more information on additional output file formats, see the *Creating Reports With WebFOCUS Language* manual.

You can also issue the ARCACHEFMT command within a request using:

```
ON TABLE SET ARCACHEFMT any_valid_database_format
```
Reference: Usage Notes for the In-Document Analytics Cache

The following apply when cache is enabled:

- The Restore Original menu option is not supported for an interactive report that contains data visualization bars.
- The Export menu option does not export a calculation applied to a tabular report.
- Comments for an accordion report are cleared if you sort output with the Sort Ascending or Sort Descending command.

Suppressing the Display of the Filter Options in a Tooltip

By default, when a user clicks a riser on an interactive chart, two filter options are displayed in the tooltip that appears. They are Filter Chart and Exclude from Chart. Using WebFOCUS StyleSheet code, you can suppress the display of the filter options. When the user clicks a riser on the chart, the options are not available, and filtering through the tooltip is disabled.

Note:

- This feature is available for an interactive chart with output format AHTML.
- This feature is not available in the GUI.

Syntax: How to Suppress the Display of the Filter Options in a Tooltip

The syntax is:

```plaintext
TYPE=REPORT, ALLOW-FILTER={ON|OFF},$
```

where:

**ON**

Displays the filter options in a tooltip when a user clicks a riser on the chart. This is the default value.

**OFF**

Suppresses the display of the filter options in a tooltip when a user clicks a riser on the chart. For example, the StyleSheet code is:

```plaintext
ON TABLE SET STYLE *
   TYPE=REPORT,
      ALLOW-FILTER=OFF,
   $
ENDSTYLE
```
Styling the Filter Selection Dialog Box

A default set of styles for the elements of an interactive report is supplied with In-Document Analytics in a JavaScript Object Notation (JSON) file named irpcfg.json. This file resides on the WebFOCUS Reporting Server. You can overwrite the default styles and apply your own custom styles to the elements of an interactive report, directly, within the individual report procedure. In the procedure, you include your custom styles in a TABLE_JS block of code with cascading style sheet (CSS) class selectors, as described in this topic. The custom styles will be applied to the report elements at run time.

This feature eliminates the need for the creation and management of multiple customized files. If you have already made customizations using the files available with your software, the customizations specified in the TABLE_JS code will overwrite them.

The TABLE_JS block of code described in this topic is an extension of the WebFOCUS reporting language. It is written in the JavaScript Object Notation (JSON) data-interchange format.

The CSS class selectors described in this topic use the standard HTML CSS class attributes.

The Filter Selection dialog box is displayed on an interactive report at run time when the user selects Filter from a drop-down column menu on the report. This topic describes specifically how to style the Filter Selection dialog box. However, you can apply the same technique to other In-Document Analytics classes, such as .activeReport class.

Note:

☑ This feature is available for an interactive report with output format AHTML.

☒ This feature is not available in the GUI.

Syntax: How to Style the Filter Selection Dialog Box

*TABLE_JS
  "styles": {
  "html":
  { "arFilterButton": [ "property:value;","..." ] }
}*

*END

where:

.arFilterButton
Is an In-Document Analytics class that defines the overall look of the buttons on the Filter Selection dialog box. There is no equivalent option in a WebFOCUS StyleSheet to overwrite this class.
Styling the Filter Selection Dialog Box

property.value
Is a CSS property:value pair that you supply to define a customized style.

Example: Styling the Filter Selection Dialog Box
The following interactive report procedure uses TABLE_JS code and CSS class selectors to style the Filter Selection dialog box.

The CSS properties as used in the sample procedure are described in the following table.

<table>
<thead>
<tr>
<th>CSS Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>font-family</td>
<td>Name of a font family that is applied to an element (for example, verdana).</td>
</tr>
<tr>
<td>padding-top</td>
<td>Top padding (space) of an element (for example, 4px for a fixed top padding).</td>
</tr>
<tr>
<td>padding-bottom</td>
<td>Bottom padding (space) of an element (for example, 4px for a fixed bottom padding).</td>
</tr>
<tr>
<td>text-align</td>
<td>Horizontal alignment of text in an element (for example, center).</td>
</tr>
<tr>
<td>font-weight</td>
<td>Thinness or thickness of characters in text (for example, bold).</td>
</tr>
<tr>
<td>background</td>
<td>Different background properties in one declaration.</td>
</tr>
<tr>
<td>background-color</td>
<td>Background color of an element (for example, green).</td>
</tr>
<tr>
<td>color</td>
<td>Color of text for an element (for example, white).</td>
</tr>
</tbody>
</table>

Note: Colors and font styles used in the sample report procedure are intended to highlight the element that is styled and to illustrate correct syntax. They are not intended to illustrate design skill.
The interactive report procedure is as follows:

```
TABLE FILE CAR
"Release - &FOCREL"
SUM RCOST DCOST
BY COUNTRY
BY CAR
ON TABLE PCHOLD FORMAT AHTML
ON TABLE SET ARTABLEENGINE JSCHART
ON TABLE SET PAGE-NUM NOLEAD
ON TABLE SET SQUEEZE ON
ON TABLE SET HTMLECSS ON
ON TABLE SET HTMLENCODE ON
ON TABLE SET CACHELINES 100
ON TABLE SET LOOKTABLE VBAR
ON TABLE SET STYLE * INCLUDE=IBFS:/FILE/IBI_HTML_DIR/javaassist/intl/EN/combine_templates/ENWarm.sty,$

*TABLE_JS

"styles": {
  "html":
  {".arFilterButton": ["font-family:verdana;", "padding-top:4px;", "padding-bottom:4px;", "text-align:center;", "font-weight: bold;", "background: green;", "background-color:green;", "color:white;"]
  }
}

*END
ENDSTYLE
END
```

At run time, the preceding code generates the following output. The TABLE_JS code is applied to the elements that are not styled in the WebFOCUS StyleSheet. For example, a green background with white text is applied to buttons on the Filter Selection dialog box, as shown in the following image.
Implementing Cascading Multi Drill

The cascading multi-drill feature enables you to:

- Create multiple drill-down links on a data field in an interactive report. For example, you can create a link to a JavaScript function, a URL, or a detailed report with data that supplements the first report and extends your scope of analysis.

- Arrange the drill-down options for a link in cascading fashion on the interactive report at runtime.

- Apply global styling to all the cascading multi-drill menus within the current interactive report, or item-level styling to a single entry on a menu.

The cascading multi-drill feature supports multiple menu items, as well as multiple cascading levels. It is implemented in the WebFOCUS language. It includes WebFOCUS StyleSheet code for the customized display of menus and menu items. Cascading multi drill can be incorporated in any interactive report that works with JavaScript (for example, HTML or DHTML).

Note: Currently, you cannot implement cascading multi drill in the GUI.
You will see a hyperlink on an interactive report when a data value on the report has drill down or multi drill. By default, the hyperlink is displayed in blue and is underlined. The following image shows an interactive report with cascading multi drill. A cascading menu is accessed at the cell level of an interactive report. In this example, the end user left-clicked the linked data field named Coffee.

<table>
<thead>
<tr>
<th>Region</th>
<th>Category</th>
<th>Product</th>
<th>Unit Sales</th>
<th>Dollar Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Midwest</td>
<td>Coffee</td>
<td>Espresso</td>
<td>101154</td>
<td>1294947</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sales Details</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Forecasts</td>
<td>By Month</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Comments</td>
<td>By Quarter</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Highlight Value</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Highlight Row</td>
<td>By Product</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unhighlight All</td>
<td>By Customer</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Filter Cell</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Northeast</td>
<td>Coffee</td>
<td>Capuccino</td>
<td>44785</td>
<td>542095</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Espresso</td>
<td>68127</td>
<td>850107</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Latte</td>
<td>222866</td>
<td>2771815</td>
</tr>
<tr>
<td>Food</td>
<td>Biscotti</td>
<td></td>
<td>145242</td>
<td>1802005</td>
</tr>
<tr>
<td></td>
<td>Croissant</td>
<td></td>
<td>137394</td>
<td>1670818</td>
</tr>
<tr>
<td></td>
<td>Scone</td>
<td></td>
<td>70732</td>
<td>907171</td>
</tr>
<tr>
<td>Gifts</td>
<td>Coffee Grinder</td>
<td></td>
<td>40977</td>
<td>509200</td>
</tr>
<tr>
<td></td>
<td>Coffee Pot</td>
<td></td>
<td>46185</td>
<td>590780</td>
</tr>
<tr>
<td></td>
<td>Mug</td>
<td></td>
<td>91497</td>
<td>1144211</td>
</tr>
<tr>
<td></td>
<td>Thermos</td>
<td></td>
<td>48870</td>
<td>604098</td>
</tr>
</tbody>
</table>
As shown in the next image, you can apply custom styling to the drill-down menus and menu items on the interactive report, using WebFOCUS StyleSheet code.

For details on the syntax for linking to other resources and for styling cascading multi-drill menus, see the Multi-Drill Feature With Cascading Menus and User-Defined Styling topic in the Linking a Report to Other Resources chapter in the Creating Reports With WebFOCUS Language manual.

Customizing the Page Range on the Pagination Bar

The default string and parameters used to display the page range on the pagination bar of an interactive report are stored on the WebFOCUS Reporting Server in a file supplied with your software. Instead of using the default values stored on the server, you can specify your own customization values within an individual interactive report procedure, using the TABLE_JS syntax described in this topic. The values specified in the TABLE_JS code will overwrite the default values, and the customized page range on the pagination bar will be displayed in the interactive report output.
This feature eliminates the need for the creation and management of multiple customized files used in many applications. If you have already made page range customizations using the files available with your software, the customizations specified in the TABLE_JS code will overwrite them.

**Note:**

- This feature is available for an interactive report with output format AHTML.
- This feature is not available in the GUI.

**Syntax:**

**How to Customize the Page Range on the Pagination Bar**

The syntax is

```javascript
*TABLE_JS
 "strings":
 { "paglinetext":"customized_string" }
*END
```

where:

- `customized_string` - are the parameters that you supply to customize the page range on the pagination bar. Valid values are described in the following table.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%inds</td>
<td>Displays the current page number and allows you to type over it with the number of a page to go to.</td>
</tr>
<tr>
<td>%ind</td>
<td>Displays the current page number. Does not allow you to type a go-to page number.</td>
</tr>
<tr>
<td>%frcs</td>
<td>Is the number of the first record that is displayed. It is a cumulative number from the first record on the first page, up to the first record on the current page.</td>
</tr>
<tr>
<td>%lrcs</td>
<td>Is the number of the last record that is displayed. It is a cumulative number from the first record on the first page, up to the last record on the current page.</td>
</tr>
<tr>
<td>%trcs</td>
<td>Is the total number of records.</td>
</tr>
</tbody>
</table>
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%pers</td>
<td>Is the percentage of the total records that are displayed when a filter is applied.</td>
</tr>
<tr>
<td>%pgs</td>
<td>Is the total number of pages.</td>
</tr>
<tr>
<td>%rcs</td>
<td>Is the total number of records when a filter is applied.</td>
</tr>
<tr>
<td>%tn</td>
<td>Is a table number used only for internal purposes.</td>
</tr>
</tbody>
</table>

**Example:** **Customizing the Page Range on the Pagination Bar**

The following interactive report procedure uses TABLE_JS code to overwrite the default page range on the pagination bar.

In this example, the number of records displayed on each report page is set in the report procedure by the WebFOCUS StyleSheet attribute LINES-PER-PAGE. You can also set the number of records (lines) per page in the GUI for InfoAssist and App Studio. For more information on the GUI procedure, see the manual for the graphical tool that you are using.

The LINES-PER-PAGE and TABLE_JS code are shown in bold in the example.

**Note:** If you want to run the example in this procedure, you must combine the two lines of code between the braces in the TABLE_JS block, so that they are a single line of code, as required by the syntax rules.
At run time, the preceding code generates the following pagination bar on the interactive report. The underscore in Page 1 indicates that you can type a go-to page number here.

1 - 10 out of 18 records, Page 1 of 2 ►►►

To remove the capability to type a go-to page number, use the %ind parameter instead of the %inds parameter in the TABLE_JS block, as shown here.

*TABLE_JS
"strings":
{ "paglinetext":"%frcs - %lrcs out of %trcs records, Page %ind of %pgs<span id='smsg%tn'></span>" }
*END

The interactive report will display the following pagination bar, with no underscore in Page 1.

1 - 10 out of 18 records, Page 1 of 2 ►►►
Index

A
adding report or dashboard to Home screen 115
Analytic Document Options dialog box 24, 82
  Colors tab 27, 85
  General tab 25, 82
  Menu Options tab 26, 83

C
cache 21
charts
  using In-Document Analytics 86
  types for mobile web apps 123

D
documents
  cascading prompts 42, 107
documents
  changing the filter condition 41, 106
  setting target reports 34, 100

G
gesture support 110

I
in-document analytics 15
  for charts 86
  interactive dashboards 33, 99

R
running report on mobile device 113
Feedback

Customer success is our top priority. Connect with us today!

Information Builders Technical Content Management team is comprised of many talented individuals who work together to design and deliver quality technical documentation products. Your feedback supports our ongoing efforts!

You can also preview new innovations to get an early look at new content products and services. Your participation helps us create great experiences for every customer.

To send us feedback or make a connection, contact Sarah Buccellato, Technical Editor, Technical Content Management at Sarah_Buccellato@ibi.com.

To request permission to repurpose copyrighted material, please contact Frances Gambino, Vice President, Technical Content Management at Frances_Gambino@ibi.com.